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Symbol Definitions 

The following table lists those symbols used in this document to denote certain conditions. 

Symbol Definition 

ATTENTION: Identifies information that requires special 

consideration. 

TIP: Identifies advice or hints for the user, often in terms of 

performing a task. 

REFERENCE -EXTERNAL: Identifies an additional source of 

information outside of the bookset. 

REFERENCE - INTERNAL: Identifies an additional source of 

information within the bookset. 

CAUTION Indicates a situation which, if not avoided, may result in equipment 

or work (data) on the system being damaged or lost, or may result in 
the inability to properly operate the process. 

CAUTION: Indicates a potentially hazardous situation which, if not 

avoided, may result in minor or moderate injury. It may also be used 
to alert against unsafe practices. 

CAUTION symbol on the equipment refers the user to the product 
manual for additional information. The symbol appears next to 
required information in the manual. 

WARNING: Indicates a potentially hazardous situation, which, if not 

avoided, could result in serious injury or death. 

WARNING symbol on the equipment refers the user to the product 

manual for additional information. The symbol appears next to 
required information in the manual. 

WARNING, Risk of electrical shock: Potential shock hazard where 
HAZARDOUS LIVE voltages greater than 30 Vrms, 42.4 Vpeak, or 
60 VDC may be accessible. 
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1.1 Characteristics 

 

Chapter 1 Introduction 

This instruction describes the dimension, handling and programming methods of HART analog output module 

(2MLF-DC4H) that can be used by combining with 2MLK/I/R PLC Series CPU module. Hereinafter, 2MLF-

DC4H is referred to HART analog output module. 

This module is used to convert the digital value of signed 16-bit binary data (data: 14 bits) specified in PLC 

CPU to analog signal (current output) and supports HART (Highway Addressable Remote Transducer) 

protocol used in many process field devices. 

 

. 

(1) It supports HART protocol 
In the output range of 4 ~ 20mA, bi-directional digital communication is available by using analog 
signal wiring. If analog wiring is currently used, there is no need to add wiring for HART 
communication (HART communication is not supported in the range of 0 ~ 20mA) 

 

(2) High resolution of 1/16000 
Through the digital value resolution of 1/16000, high resolution of analog value can be obtained. 

 
(3) High accuracy 

High accuracy of ±0.1% or less (when ambient temperature is 25℃) 
 

(4) Various output ranges available 
4~20mA, 0~20mA 

 

(5) Output limit setting is available. 
The range of digital input value can be limited. 

 

(6) Rate control setting is available. 
The rate or digital input value can be set. 

 

(7) Various formats of digital input data provided. 
4 formats of digital input data are available as specified below. 

(a) Unsigned Value: 0 ~ 16000 
(b) Signed Value: -8000 ~ 8000 
(c) Precise Value: Refer to Chapter 2.2 Display based on analog input range. 
(d) Percentile Value: 0 ~ 10000 
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The HART analog module can be used with Asset Management Software such as a tool like  
PACTware software of P+F and FDM(Field Device Manager) of Honeywell as shown below. 

 

 
 It’s combined the HART AI/AO module which is installed on MasterLogic PLC and conveyed the 
captured data to upside of Asset Management over COM/DTM, to integrate with FDM for 
Honeywell. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1.2 Asset Management Software 
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2.1 General Specifications 

 
 

Chapter 2 Specifications 
 

General specifications of 2MLK/2MLI/2MLR series are as specified below. 
 

No. Item Specifications 
Related 

specifications 

1 
Ambient 

temperature 0 ~ 55 C - 

2 
Storage 

temperature −25 ~ +70 C - 

3 
Ambient 
humidity 

5 ~ 95%RH (Non-condensing) - 

4 Storage humidity 5 ~ 95%RH (Non-condensing) - 

 
 
 

 
5 

 
 
 

Vibration 
resistance 

Occasional vibration - - 

Frequency Acceleration Amplitude How many times  
 
 

IEC61131-2 

5 ≤ f < 8.4Hz - 3.5mm  

 
10 times each 

directions 

(X, Y and Z) 

8.4 ≤ f ≤ 150Hz 9.8 ㎨ (1G) - 

For continuous vibration 

Frequency Acceleration Amplitude 

5 ≤ f < 8.4Hz - 1.75mm 

8.4 ≤ f ≤ 150Hz 4.9 ㎨ (0.5G) - 

 
6 

 
Shock resistance 

• Peak acceleration: 147 m/s2(15G) 

• Duration: 11ms 

• Half-sine, 3 times each direction per each axis 

 
IEC61131-2 

 
 
 
 
 

7 

 
 
 
 
 

Noise resistance 

Square wave 

Impulse noise 

AC: ± 1,500V 

DC: ± 900V 

 

Electrostatic 

discharge 
Voltage : 4kV (contact discharging) 

IEC 61131-2, 
IEC 61000-4-2 

Radiated 

electromagnetic 

field noise 

 
80 ~ 1,000 MHz, 10V/m 

IEC 61131-2, 
IEC 61000-4-3 

Fast transient 

/bust noise 

Segment 
Power supply 

module 

Digital/analog input/output 

communication interface 
IEC 61131-2, 

IEC 61000-4-4 
Voltage 2kV 1kV 

8 Environment Free from corrosive gasses and excessive dust - 

9 Altitude Up to 2,000 ms - 

10 Pollution degree Less than equal to 2 - 

11 Cooling Air-cooling - 

 

Notes  

(1) IEC (International Electrotechnical Commission): 

An international nongovernmental organization which promotes internationally cooperated standardization in 

electric/electronic fields, publishes international standards and manages applicable estimation system related 

with. 

(2) Pollution level: 

An index indicating pollution level of the operating environment which decides insulation performance of the 

devices. For instance, Pollution level 2 indicates the state generally that only non- conductive pollution occurs. 

However, this state contains temporary conduction due to dew produced. 
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Performance specifications of HART analog output module are as specified in table below. 
 

Item Specification 

 

 
Analog output 

DC 4 ~ 20 mA 

DC 0 ~ 20 mA 
(Load resistance: 600Ω or less) 

► Analog output range can be selected through user program or [I/O parameter]. 

► Respective output ranges can be set based on channels. 

 
 
 

 
Digital input 

 

 
 
 
 
 

► Format of digital input data can be set through user program or [I/O Parameter setting] 
respectively based on channels. 

 
 

Maximum resolution 

1/16000 (for respective output ranges) 

4~20 mA 1.0 ㎂ 

0~20 mA 1.25 ㎂ 

Accuracy 
±0.1% or less (when ambient temperature is 25℃) 

±0.3% or less (when ambient temperature is 0℃ ~ 55℃) 

Maximum conversion 
speed 

100 ㎳/4 channels 

Absolute maximum 
output 

DC 24 mA 

Number of output 
channels 

4 channels/1 module 

Isolation method 
Photo-coupler isolation between input terminal and PLC power 

(no isolation between channels) 

Terminal connected 18-point terminal 

I/O points occupied Fixed type: 64 points, Non fixed type: 16 points 

HART communication 
method 

Monopoly only 
Primary master only 

 
Current consumption 

Internal DC5V : 200 ㎃ 

External DC24V : 220 ㎃ 

Weight (g) 150g 

 
 

Notes  

(1) When Analog Output Module is made at factory, Offset/Gain value about analog output range is 
fixed and you can’t change them. 

(2) Offset Value: Digital input value of which analog output value becomes 4 ㎃ when you set analog 

output range as 4 ~ 20 ㎃. 

(3) Gain Value: Digital input value of which analog output value becomes 20 ㎃ when you set analog 

output range as 4 ~ 20 ㎃. 

(4) HART communication is available when output rage set to 4~20 ㎃. 

2.2 Performance Specifications 

Analog output 
Digital input 

4 ~ 20mA 0 ~ 20mA 

Unsigned Value 0 ~ 16000 

Signed Value -8000 ~ 8000 

Precise Value 4000 ~ 20000 0 ~ 20000 

Percentile Value 0 ~ 10000 
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Respective designations of the parts are as described below. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

No. Description 

LED Display RUN LED 
 

Displays the operation status of 2MLF-DC4H module 

 On: Operation normal 
 Flickering: Error occurs (Refer to 7.1 for more details) 
 Off: DC 5V disconnected, 2MLF-DC4H module error 

ALM LED 
 

Displays the warning status of 2MLF-DC4H module 

 Flickering: Error occurs (Control of change rate, limitation of output setting) 
 Off: Operation normal 

Analog Terminal Analog Terminal 
 

 
Analog terminal, whose respective channels can be connected with external devices 

Power Terminal Power Terminal 
 

 
Supply terminal of external power DC24V (No.17~18) 

2.3 Respective Designations and Functions 
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2.4.1 Summary 
HART analog output module is a product that can use HART communication along with analog 
conversion. HART analog output module supports interface for communication by being connected with 
HART field device. Communication data provided by HART field device can be monitored via HART 
analog output module and status of field devices can be also diagnosed. 

 
(1) Advantage and Purpose of HART Communication 

(a) Additional wiring for communication is not needed(Communication by using 4~20mA wiring of 
analog module) 

(b) Additional measurement information through digital communication 
(c) Low power consumption 
(d) Various field devices that support HART communication 
(e) Display of field device’s information, maintenance, diagnosis 

 

(2) HART Communication Composition 

HART communication consists of masters and slaves and up to two masters can be connected. PLC 
HART analog output module is connected as the primary master device and communicates with field 
devices-slaves. A communication device is connected as the secondary master device to diagnose 
field devices and set its slave’s parameters. 

 
Smart mass flow meter provides flow’s field measuring values with the flow meter’s current signal. 
Along with signal current indicating flow, it sends additional measurement information measured by 
the flow meter to HART communication. Up to four variables are provided. For example, flow as the 
Primary Value (PV), stop pressure as the Secondary Value(SV), temperature as the Tertiary 
Value(TV) and current signal’s digital value as the Quaternary Value(QV) are used as measurement 
information. 

 
(3) Multidrop 

Multidrop method consists of only one pair of wiring and all control values are transmitted in digital 
ones. All field devices have polling addresses and the current flow in each device is fixed to the 
minimum value (4 mA). 

 

Notes  

- Multidrop method is not supported on HART analog input and output module. 

2.4 Basic Characteristics of HART Analog Module 
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Analog 

signal 

C: Command(K) 

R : Response(A) 

Time 

 

2.4.2 HART Operation 
(1) HART signal 

The figure below illustrates HART signals whose frequency is modulated to analog signal. In this 

figure, HART signal is shown as two kinds of signals that have frequency of 1,200 ㎐ and 2,200 ㎐. 

These two kinds of signals refer to binary number 1(1,200 ㎐) and 0(2,200 ㎐) and they are recovered 

to meaningful information by being demodulated into digital signal on each device. 

(2) Kind and Configuration of HART Commands 

Kinds of HART commands are described. HART analog output module transmits HART commands 
to HART field device and HART field device transmits responses to the commands to HART analog 
output module. HART commands can be categorized into three command groups according to their 
characteristics and they are called Universal, Common Practice, and Device Specific. Universal 
commands shall be supported by the entire HART field device manufacturers as an essential command 
group. Common Practice defines only data format of commands and manufacturers support only items 
that are judged as essential ones for HART field device. Device Specific is a command group that has no 
specified data format. Each manufacturer can define it if needed. 

 
[Table 2.3] HART Commands 

Command Description 

Universal 
An essential command group that shall be supported by all of HART field device 
manufacturers 

Common Practice 
Only data format of commands is defined and manufacturers support only items that 
are judged as essential ones for HART field device 

Device Specific 
A command group that has no specified data format. Each manufacturer can define 
it if needed 
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(3) Commands supported on HART analog output module 

Commands supported on HART analog output module are described in the following. 

 
[Table 2.4] Commands supported on HART analog input module 

 

Command Function 

 
 
 

 
Universal 
Command 

0 Read Manufacturer ID and Manufacturer device code 

1 Read Primary variable(PV) value and Unit 

2 Read percentage of current and range 

3 
Read current and 4 kinds of variable values 
(Primary Variable, Secondary Variable, Tertiary Value, Quaternary Value) 

12 Read message 

13 Read tag, descriptor, data 

15 Read output information 

16 Read Final Assemble Number 

 

Common 
Practice 
Command 

48 Read Device Status 

50 Read Primary variable~ Quaternary Variable assignment 

57 Read Unit tag, Unit descriptor, Date 

61 Read Primary variable~ Quaternary Variable and PV analog output 

110 Read Primary variable~ Quaternary Variable 
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Characteristics of I/O conversion are displayed in a straight line with the inclination as shown below 
when converting digital signal specified in PLC to analog signal (current). 
Input formats of digital data are classified into Unsigned Value, Signed Value, Precise Value and 
Percentile Value, and I/O conversion characteristics for respective digital input ranges are as described 
below. 

 
2.5.1 Characteristic of current output 

 
Current output range can be selected through user program or special module parameters setting for 

respective channels. 

2.5 Characteristics of I/O Conversion 

Digital Input Value 

A
n

a
lo

g
 C

u
rre

n
t O

u
tp

u
t 
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(1) If the range is 4~20㎃ 

► On the SoftMaster menu [I/O Parameters Setting], set [Output range] to “4 ~ 20㎃”. 

 
 

Digital Input 
Analog Current Output Maximum 

Resolution 3.808 4 8 12 16 20 20.192 

Unsigned value -192 0 4000 8000 12000 16000 16191  
1.0 ㎂ Signed value -8192 -8000 -4000 0 4000 8000 8191 

Precise value 3808 4000 8000 12000 16000 20000 20192 

Percentile value -120 0 2500 5000 7500 10000 10119 1.6 ㎂ 

※ In the case of 4~20 ㎃ current output, analog current output for digital value of “1” is equivalent to 1.0 ㎂. 

 
(2) If the range is 0~20㎃ 

► On the SoftMaster menu [I/O Parameters Setting], set [Output range] to “0 ~ 20 

㎃”.  
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Digital Input 
Analog Current Output Maximum 

Resolution - 0 5 10 15 20 20.24 

Unsigned value 0 0 4000 8000 12000 16000 16191 
1.25 ㎂ 

Signed value 0 -8000 -4000 0 4000 8000 8191 

Precise value 0 0 5000 10000 15000 20000 20192 1.0 ㎂ 

Percentile value 0 0 2500 5000 7500 10000 10119 2.0 ㎂ 

※ In the case of 0~20 ㎃ current output, analog current output for digital value of “1” is equivalent to 1.25 

㎂. 

 
2.5.2 Accuracy 

Although the output range is changed, the accuracy for the analog output value does not change. 

Fig. 2.1 shows the accuracy change range at the ambient temperature of 25 ± 5 ℃. The analog 

output range is set between 4 to 20 mA and an unsigned integer is selected for the input type. 

(±0.1% at 25 ± 5 ℃, ±0.3% at 0 ~ 55 ℃) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[Fig 2.1] Accuracy 

   Digital Input Value  
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2.6.1 Output status setting 
In case of CPU module’s stop or abnormal status, set analog output status. 

 
(1) Function description 

If any error occurs on the module’s Initialize or PLC system, this function is used to output HART 

analog output module’s output current with the designated value. 

(2) Setting kind 

Each channel’s output status can be set one among Previous Value, Minimum, Median and 
Maximum. 
(a) Previous Value: Retain the last output that runs normally. 
(b) Minimum: Minimum value output for each output range 
(c) Median: Median output for each output range 
(d) Maximum: Maximum output for each output range 

 
(3) Setting example 

If any error occurs on the system when output range is set to 4 ~ 20 ㎃ and analog output value of 

10 ㎃ is outputted, analog output status will work as following: 

(a) Previous Value: Retain 10 ㎃ output-the previous output 

(b) Minimum: 4 ㎃ output-the minimum value of the relevant range 

(c) Median: 12 ㎃ output-the median of the relevant range 

(d) Maximum: 20 ㎃ output-the maximum value of the relevant range 

 
(4) Analog output value of each operation mode 

 
(a) Normal Mode 

 

CPU status Output Status 
Channel 

Remarks 
Run Stop 

 
RUN 

Enabled Digital Input Value 0V or 0 ㎃  

0 : previous value kept 
1 : minimum value 

output 
2 : middle value output 
3 : maximum value 

output 

Disabled 
As specified Setting 

output type 0V or 0 ㎃ 

 
STOP 

Enabled 
As specified Setting 

output type 0V or 0 ㎃ 

Disabled 
As specified Setting 

output type 0V or 0 ㎃ 

 
(b) Test Mode 

 

CPU status Output Status 
Channel 

Remarks Run Stop 

 
STOP 

Enabled Digital Input Value 0V or 0 ㎃ 
0 : previous value kept 
1 : minimum output 
2 : middle output 
3 : maximum output 

Disabled 
As specified Setting 

output type 
0V or 0 ㎃ 

※ Test Mode is available only when CPU is in STOP status. 

2.6 Functions of Analog Output Module 
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(c) If any isolated DA module error occurs 
 

CPU status Output Status 
Channel 

Remarks Run Stop 

 
RUN 

Enabled Note1) 0V or 0 ㎃ 
 
 
 

0 : previous value kept 
1 : minimum output 
2 : middle output 
3 : maximum output 

Disabled 
As specified Setting 

output type 0V or 0 ㎃ 

 
STOP 

Enabled 
As specified Setting 

output type 0V or 0 ㎃ 

Disabled 
As specified Setting 

output type 
0V or 0 ㎃ 

When Power is on /H/W error 0V or 0 ㎃ 

 

Note1) Output value setting error: upper limit or lower limit, Parameter setting error: as specified CH output type 

 
 

(d) If any CPU error occurs 
 

CPU status Output Status 
Channel 

Remarks Run Stop 

 
ERROR 

Enabled  
0V or 0 ㎃ 

 

Disabled 
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2.6.2 Output limit setting 

Output limit function limits the High/Low output limit for digital input value which is defined by user. 
When the Output limit function is set, if the setting value of High limit value is more than digital input 
value which is defined by user, analog output value is High limit value. And, if the digital input value 
which is defined by user is smaller than Low limit value, analog output value is Low limit value. 

 
(1) Output limit: Disable/Enable 
(2) High limit value: -192~16191 (Actual range is from Low limit value to 16191.) 
(3) Low limit value: -192~16191 (Actual range is from -192 to Low limit value.) 
(4) I/O parameter setting is as shown below. 

 

(a) Set the Output limit to Enable. 

 
 

(b) Set the High limit value. 
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Digital input value 
Digital input value 
Analog output value 

High limit value 

Low limit value 

High limit value 

 
Low limit value 

 
Low limit value 
cancel 

 

(c) Set the Low limit value. 

 
 

(d) Analog output value is as shown below when set the Output limit. 
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2.6.3 Rate control setting 

Rate control specifies the increase/decrease rate of analog output value for digital input value which is 
defined by user. 

 
(1) Rate control: Disable/Enable 
(2) Increase limit value: 0~16000 
(3) Decrease limit value: 0~16000 
(4) I/O parameter setting is as shown below. 

 
(a) Set the Rate control setting to Enable. 

 
 

(b) Set the Increase limit value. 
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Ex.) Increase limit value: 2000 
Decrease limit value: 2000 

 

Digital input value 

Digital input value 
Analog output value 

Time (ms) 

 

(c) Set the Decrease limit value. 

 
 

(d) Analog output value is as shown below when set the rate control 
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3.1 Installation 

 

Chapter 3 Installation and Wiring 
 

3.1.1 Installation environment 

This product is of high reliance regardless of installation environment. However, for the sake of 

reliance and stability of the system, please pay attention to those precautions described below. 

(1) Environmental conditions 

- To be installed on the control panel waterproof and dustproof. 

- No continuous impact or vibration shall be expected. 

- Not to be exposed to the direct sunlight. 

- No dew shall be caused by rapid temperature change. 

- Ambient temperature shall be kept 0-55℃. 

 

(2) Installation 

- No wiring waste is allowed inside PLC when wiring or drilling screw holes. 

- To be installed on a good location to work on. 

- Don’t let it installed on the same panel as a high-voltage device is on. 

- Let it kept at least 50㎜ away from duct or near-by module. 

- To be grounded in an agreeable place free from noise. 

 
3.1.2 Precautions for handling 

Precautions for handling 2MLF-DC4H module are as described below from the opening to the 

installation. 

(1) Don’t let it dropped or shocked hard. 

(2) Don’t remove PCB from the case. It will cause abnormal operation 

(3) Don’t let any foreign materials including wiring waste inside the top of the module when 

wiring. Remove foreign materials if any inside. 

(4) Don’t install or remove the module while powered on. 

(5) The attachment torque of fixed screw of module and the screw of terminal block should be within 
the range as below. 

Attachment part Attachment Torque range 

I/O module terminal block screw (M3 screw) 42 ~ 58 N·㎝ 

I/O module terminal block fixed screw (M3 screw) 66 ~ 89 N·㎝ 

 
 
 
 
 
 
 
 
 

Notes  

- HART analog output module can use when installed in extended base in 2MLR systems. 
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Channel Polarity Terminal no. 

CH0 
+ 1 

- 2 

CH1 
+ 3 

- 4 

CH2 
+ 5 

- 6 

CH3 
+ 7 

- 8 

 
 
 

 
- 

NC 9 

NC 10 

NC 11 

NC 12 

NC 13 

NC 14 

NC 15 

NC 16 

NC 17 

NC 18 

 

3.2 Wiring 

Current output 
CH0+ 

+ 

_ 
CH0- 

2 
1 

4 
3 

6 
5 

8 
7 

9 

10 

12 
11 

14 
13 

15 
16 

18 
17 

 

 

 
 

 

 

3.2.1 Precautions for wiring 

(1) Use a cable for external output sign of 2MLF-DC4H module separate from the alternating current 

so to be free from surge or inductive noise produced from the alternating current side. 

(2) Cable shall be selected in due consideration of ambient temperature and allowable current, whose 

size is not less than the max. cable standard of AWG22 (0.3㎟). 

(3) Don’t let the cable too close to hot device and material or in direct contact with oil for long, which will 

cause damage or abnormal operation due to short-circuit. 

(4) Check the polarity before external power is supplied to the terminal. 

(5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal 

operation or defect. 

 
 

3.2.2 Wiring examples 
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2MLF-DC4H 

 

Motor Driver etc. 
 

 
 

 1 : Use a 2-core twisted shielded wire. 
 

 

 

TIP 

• In current output, there is no accuracy tolerance caused by cable length and internal 
resistance of the source. 

• Set to enable the channel only to be using. 

 

3.2.3 Maximum communication distance 

(1) HART communication is available up to 1㎞. But, if a transmitter presents the max communication 

distance, apply the shorter distance among the transmitter’s communication distance and 1㎞. 

(2) The max communication distance may vary according to the cable capacitance and resistance. To 
ensure the max communication distance, check the cable’s capacitance and length. 

(3) Example of cable selection to secure communication distance 
(a) If the cable capacitance is less than 90pF and the cable resistance is less than 0.09Ω, the 

distance available for communication will be 1 ㎞. 

(b) If the cable capacitance is less than 60pF and cable resistance is less than 0.18Ω, the distance 

available for communication will be 1 ㎞. 

(c) If the cable capacitance is less than 210pF and cable resistance is less than 0.12Ω, the distance 

available for communication will be 600m. 

 
 Resistance (Ω/m) 

0.03 0.06 0.09 0.12 0.15 0.18 0.21 0.24 

 

 
Cable 
Capacitance 

(㎊/m) 

1,200 100 m 100 m 100 m 100 m 100 m 100 m 100 m 100 m 

750 100 m 100 m 100 m 100 m 100 m 100 m 100 m 100 m 

450 300 m 300 m 300 m 300 m 300 m 300 m 300 m 300 m 

300 600 m 300 m 300 m 300 m 300 m 300 m 300 m 300 m 

210 600 m 600 m 600 m 600 m 600 m 300 m 300 m 300 m 

150 900 m 900 m 600 m 600 m 600 m 600 m 600 m 600 m 

90 1,000 m 1,000 m 1,000 m 900 m 900 m 900 m 900 m 600 m 

60 1,000 m 1,000 m 1,000 m 1,000 m 1,000 m 1,000 m 900 m 900 m 

   CH0 

1 

2 

*1 

   

   

Less than 

600Ω 

PE 

Motor Driver etc. 

   CH3 
*1 

7 

8 

Less than 

600Ω 

PE 

17 

18 

DC +24V 

DC 0V 

DC/DC 

Conversion 

Circuit 

D/A 

Conversion 

Circuit 

D/A 

Conversion 

Circuit 

D/A 

Conversion 

Circuit 

D/A 

Conversion 

Circuit 
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Will you specify operation 

parameters through [I/O 

Parameter Setting]? 

YES 

 

Connect D/A conversion module with the external device. 

Specify operation parameters through 

[I/O Parameter Setting] 

4.1 Operation Procedures 

 

Install D/A conversion module the slot. 

Start 

END 

 

Prepare PLC program 
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The processing for the operation is as shown in Fig. 4.1 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NO 
 
 
 
 
 
 

 

[Fig. 4. 1] Procedures for the operation 
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4.2.1 Setting items 

Module’s operation parameters can be specified through SoftMaster’s [I/O parameters]. 

Analog Output module is used to execute parameters setting and monitoring/test function of the applicable 
module through SoftMaster menu or tool bar, or read/write the data of internal memory by means of the 
scan program. 

Setting I/O parameters 

Step Action 

1 Run SoftMaster to create a project. (Refer to ML200 CPU and SoftMaster User’s Guide, for 
details on creating the project). 

2 In the Project Window, double-click I/O Parameters. 

3 On the I/O Parameters Setting screen, click the slot number on which the base module is 

installed. 

4 Click the arrow button on the screen above to display the screen where an applicable module 
can be selected. 

5 Search for the applicable module to select. 

The I/O Parameter Setting – Variable allocation dialog box appears where you can specify the 
parameters for the respective channels. 

6 Click the required item to view the parameters to be set for the respective items. 

7 Double-click the applicable slot selected for parameters setting or click [Details]. 

8 Specify the individual parameters as follows: 

a) Channel status: Select Disable or Enable. 

b) Analog output range: Select the range of analog output voltage as desired. 2MLF-DC4H 

module provides 2 current output ranges. 

c) Input data type: Select the format of input data. 4 formats are available in total. 

d) Setting output type: Select the type of output status. 4 ranges are available in total. 

e) Rate control: Select Disable or Enable. 

f) Increase/Decrease limit value: The setting range is from 0 to 16000. 

 g) Output limit setting: Select Disable or Enable. 

h) High/Low limit value: The setting range is from -192 to 16191. 

i) HART: Select Enable or Disable. 

9 Specify parameters as necessary. After setting, click [OK]. 

. 

 

4.2.2 How to use [I/O parameters] 

How to use [I/O parameters] will be described below. 

(1) Run SoftMaster to create a project. (Refer to SoftMaster program manual for details on how to 

create the project) 

(2) Double-click [I/O parameters] on the project window. 
 

4.2 Operation Parameter Setting 
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(3) On the ‘I/O Parameter Setting’ screen, find and click the slot of the base module is installed on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(4) Click the arrow button on the screen above to display the screen where an applicable module can 

be selected. Search for the applicable module to select. 
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(5) A screen will be displayed for you to specify parameters for respective channels as shown below. 

Click a desired item to display parameters to set for respective items. 

Double-click the applicable slot selected for parameters setting or click [Details]. 

 

(a) Channels: Select Disable or Enable. 
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(b) Analog output range: Select the range of analog output voltage as desired. 2MLF-DC4H 

module provides 2 current output ranges. 

 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 

 
(c) Input data type: Select the format of input data. 4 formats are available in total. 

 

(d) Setting output type: Select the type of output status. 4 ranges are available in total. 
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(e) Rate control: Select Disable or Enable 

 

(f) Increase/Decrease limit value: The setting range is from 0 to 16000. 

 
(g) Output limit setting: Select Disable or Enable. 
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(h) High/Low limit value: The setting range is from -192 to 16191. 

(i) HART: Select Enable or Disable 

 

 
 

(6) Specify parameters as necessary. After setting, click [OK]. 
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(7) Default of parameters setting 
 
 

Parameter Setting Item Default 

Channel status Disable/Enable Disable 

Output range 4~20 ㎃/0~20 ㎃ 4~20 ㎃ 

 

Input type 
0~16000/-8000~8000/ 

4000~20000/0~10000% 
(Changed based on the output range) 

 

0~16000 

Ch. Output type Prev/Min/Mid/Max Previous 

Rate control Disable/Enable Disable 

Increase limit value 0~16000 0 

Decrease limit value 0~16000 0 

Output limit Disable/Enable Disable 

High limit value -192~16191 16000 

Low limit value -192~16191 0 

HART Disable/Enable Disable 

 

(8) How to select the whole channels to change parameters. 

Click and check the button in the parameters item in order to change the whole channels to 

identical setting value. And then change the parameters of an optional channel to change the 

parameters of the whole channels at a time. The Figure below shows an example that the channel 

is changed to whole channels ‘Enable’ by means of this function. 
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4.3.1 Monitoring / Test screen 

 

The special module monitoring function helps you to monitor the Analog Output modules for testing. It 
also helps in tuning parameters like average processing constants. 

To monitor and test the module, perform the following steps. 

Step Action 

1 Click [Online] -> [Connect] and [Monitor] -> [Special Module Monitoring] to start. If the 
status is not [Online], [Special Module Monitoring] menu is not available. 

2 With SoftMaster connected to PLC CPU (Online status), click [Monitor] -> [Special Module 
Monitoring] to display the ‘Special Module List’ screen, displaying the base/slot information in 
addition to special module type. The module installed on the present PLC system displays on the 
list dialog box. 

3 Select Special Module and then click [Module Info.] to display the information. 

4 After the module is selected, click [Monitor] to display the monitoring screen. 

5 [Start Monitoring]: Click [Start Monitoring] to view analog output value of the presently 
operated channel. 

  

 

6 [Test]: [Test] is used to change the presently specified parameters of HART Analog Output 
module. Click the setting value at the bottom field of the screen to change parameters. [Test] 
can be set only when CPU operation status is in [Stop]. 

 

4.3 Monitoring /Test 
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Step Action 

 
 

 

7 [Setting Value Change] -> [Test] -> Change current value 

[Close]: Click [Close] to exit. 
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4.3.2 HART Variable Monitoring and Device Information Screen. 

 

Step Action 

1 PV, Primary Variable monitor: Click [Implement Test] after setting HART 
communication to ‘Enable’ on the ‘Special Module Monitor’ screen to check 
PV transmitted from a field device connected with channel 1 to HART 
communication. The following figure displays the screen to view PV imported 
from the field device connected with channel 0. 

 

 

2 [HART device information]: Click [Read] button on the bottom after clicking 
[HART device information] on the ‘Special Module Monitor’ screen. 

Information on HART device that connect with a current module can be viewed 
for each channel. 
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3 If the current value cannot be seen completed on HART device information 
screen because the value is too long, click and drag the current value to view. 
In case of [Monitor] -> [Monitor Special Module] -> [HART Device Information] 

-> [Read], h00F1 is written on the actual HART command setting status 
because command h00F1 is written inside of SoftMaster. To delete, use 
HARTCLR command. In case of [Monitor] -> [Monitor Special Module] -> 
[Start Monitor] -> [HART Device Information] -> [Read], h00F3 is written 
on the actual HART command setting status because command h00F3 is 
written inside of SoftMaster. To delete, use HARTCLR command. 
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• Message: Texts that are inputted to HART field device’s message 
parameters. They can be used to describe information helpful to recognize 
a device. 

• Tag: HART field device’s tag name is displayed. It can be used to indicate 
the location of a plant. 

• Descriptor: HART field device’s descriptor field is displayed. For example, 

it can be used to save the name of a person who performs calibration. 

• Date: Date inputted to the device. It can be used to record the latest 

calibration date or date of maintenance/inspection. 
Write Setting (Write Prevented): Information on whether HART field device 
is protected from writing is displayed Yes or No. If Yes is set, certain 
parameters cannot be changed through HART communication. 

• Manufacturer: Manufacturer name is displayed. Its code can be displayed 
and code information is changed to text to be displayed on the [HART 
device information] screen. 

• Device Name (type): It can be used for a manufacturer to designate a 

device type or name. Code information is changed to text to be displayed 
on the [HART device information] screen. 

• Device ID: Numbers refers to device ID are displayed. Device ID is a 

unique serial number issued by the manufacturer. 

• Final Assemble Number: Numbers referring to the final assembly number 
are displayed. It is used by the device manufacturer to classify changes in 
hardware. For example, it is used to classify part changes or drawing 
changes. 

• PV Upper Range Value: It is defined according to the relationship 

between dynamic variable values from the device and analog channel’s 
upper end points. That is, PV is displayed if the output value is 20mA. 

• PV Lower Range Value: It is defined according to the relationship 
between dynamic variable values from the device and analog channel’s 
lower end points. That is, PV is displayed if the output value is 4mA. 

• Damping Time: A function to mitigate sudden changes in input (shocks) 
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and apply them to output. Its unit is of second. Mainly it is used on the 
pressure transmitter. 

• Transfer Function: A function to express which method is used by the 
transmitter to transfer 4~20mA signal to PV. 

• Universal version: It refers to HART dimension version. In most cases, it 

is 5 or 6 and 7 means Wireless HART dimension. 

• Device version: HART device’s version is displayed. 

• Software version: HART device’s software version is displayed. 

• Hardware version: HART device’s hardware version is displayed. 

 

4 Read Cancel: Press ESC on the keyboard to cancel importing information 
from HART device after pressing Read button. 
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4.3.3 Operation by program 

(1) HART analog output module can be operated with Tx. (Write) instruction of PUT/PUTP and Rx. 

(Read) instruction of GET/GETP executed from PLC CPU by means of the scan program. 

(2) Refer to Chapter 6 Programming for more details. 
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This section describes the automatic registration function of the U device in the SoftMaster 

 
 

4.4.1 Register U Devices 

Register the variables for each module referring to the special module information that is set in the 

I/O parameter. The user can modify the variables and comments. 

 
[Procedure] 

(1) Select the special module type in [I/O parameter] setting window. 

 
 

 Registering variables manually 

(2) Select [Edit] -> [Register U Device]. 

4. 4 Register U Devices 
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(3) Click ‘Yes’. 

 

(4) As shown below, the variables are registered. 
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Register U devices 

Register the variables for each module referring to the special module information that is 

set in the I/O parameter. The user can modify the variables and comments. 

Step Action 

1 Select the special module type from the [I/O parameter] setting window. 

2 Double-click [Variable/Comment] in the project window. 

3 Select [Edit] -> [Register U Device]. 

4 Click ‘Yes’. The variables are registered. 

 

Save variables 

Step 

 

Action 

1 The contents of ‘View Variable’ can be saved as a text file. 

2 Select [Edit] -> [Export to File]. 

3 The contents of ‘View variable’ are saved as a text file. 

 

4.4.2 View variables 
 

(1) The example program of SoftMaster is shown below. 

 
 

(2) Select [View] -> [Variables]. The devices are changed into variables. 
 

 

 
(3) Select [View] -> [Devices/Variables]. Devices and variables are both displayed. 
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(4) Select [View] -> [Device/Comments]. Devices and comments are both displayed. 

 

(5) Select [View] -> [Variables/Comments]. Variables and comments are both displayed. 
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5.1 Configuration of Internal Memory 

 

 

Chapter 5 Configuration and Function of Internal Memory 

(For 2MLK) 
HART Analog Output Module has the internal memory to transmit/receive data to/from PLC CPU. 

 
 

Configuration of internal memory is as described below. 

 
5.1.1 I/O area configuration of HART analog output module. 

I/O area of D/A converted data is as displayed in Table 5.1 

 
[Table 5. 1] I/O area of D/A converted data 

Device assigned Details R/W Sign direction 

UXY.00.0 
UXY.00.1 
UXY.00.2 
UXY.00.3 
.. 
UXY.00.8 
UXY.00.9 
UXY.00.A 
UXY.00.B 
.. 
UXY.00.F 

CH0 error 
CH1 error 
CH2 error 
CH3 error 
.. 
CH0 HART communication error 
CH1 HART communication error 
CH2 HART communication error 
CH3 HART communication error 
.. 
Module READY flag 

 
 
 
 

R 

 
 
 
 

D/A → CPU 

UXY.01.0 
UXY.01.1 
UXY.01.2 
UXY.01 3 
.. 
UXY.01 8 
UXY.01 9 
UXY.01 A 
UXY.01 B 
UXY.01 C 

UXY.01 D 
UXY.01 E 
UXY.01 F 

CH0 run flag 
CH1 run flag 
CH2 run flag 
CH3 run flag 
.. 
CH0 output high limit detection flag 
CH0 output low limit detection flag 
CH1 output high limit detection flag 
CH1 output low limit detection flag 
CH2 output high limit detection flag 
CH2 output low limit detection flag 
CH3 output high limit detection flag 
CH3 output low limit detection flag 

 
 
 
 

 
R 

 
 
 
 

 
D/A → CPU 

UXY.02 Output status setting W  
 
 

 
CPU → D/A 

UXY.02.0 
UXY.02.1 
UXY.02.2 
UXY.02.3 

CH0 output enable 
CH1 output enable 
CH2 output enable 
CH3 output enable 

 
W 

UXY.03 CH0 digital input value W 

UXY.04 CH1 digital input value W 

UXY.05 CH2 digital input value W 

UXY.06 CH3 digital input value W 
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(1) In the device assigned, x stands for the Base No. and y for the Slot No. on which module is installed. 
(2) In order to read ‘CH1 digital input value’ of HART analog output module installed on Base No.0, Slot 

No.4, it should be displayed as U04.03. 
 
 
 

 

(3) In order to read ‘CH3 output low limit detection flag’ of HART analog output module installed on Base 
No.0, Slot no.5, it should be displayed as U5.01.F. 
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5.1.2 Setting area of operation parameters 

Setting area of D/A conversion module’s operation parameters is as described in Table 5.2. 

 
[Table 5. 2] Setting area of operation parameters 

 

Memory address 
Description R/W Remarks HEX DEC 

0H 0 Channel enable/disable setting R/W PUT 

1H 1 Setting ranges of output current R/W PUT 

2H 2 Input data format setting R/W PUT 

3H 3 CH0 output status setting  
R/W 

 
PUT 

4H 4 CH1 output status setting 
5H 5 CH2 output status setting 

6H 6 CH3 output status setting 

- - - - - 
BH 11 CH0 error code  

R 

 
GET 

CH 12 CH1 error code 
DH 13 CH2 error code 
EH 14 CH3 error code 

- - - - - 
13H 19 Channel output limit setting R/W PUT 
14H 20 CH0 output H limit  

 

 
R/W 

 
 

 
PUT 

15H 21 CH0 output L limit 
16H 22 CH1 output H limit 

17H 23 CH1 output L limit 

18H 24 CH2 output H limit 

19H 25 CH2 output L limit 
1AH 26 CH3 output H limit 
1BH 27 CH3 output L limit 

1CH 28 Channel change rate control setting R/W PUT 

1DH 29 CH0 change rate increase limit value  
 

 
R/W 

 
 

 
PUT 

1EH 30 CH0 change rate decrease limit value 

1FH 31 CH1 change rate increase limit value 

20H 32 CH1 change rate decrease limit value 
21H 33 CH2 change rate increase limit value 
22H 34 CH2 change rate decrease limit value 

23H 35 CH3 change rate increase limit value 

24H 36 CH3 change rate decrease limit value 

- - - - - 
28H 40 HART communication Enable/Disable R/W PUT 
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5.1.3 HART commands information area 

Information area of HART commands are as described in Table 5.3 

 
[Table 5. 3] Information area of HART commands 

Memory Address 
Description R/W Remarks CH0 CH1 CH2 CH3 

68 69 70 71 HART communication error count of CH# 
 

 
R/W 

 
GET 

72 73 74 75 Communication/field device status of CH# 

76 
Select to retain data in case of HART communication 
error 

PUT 

※ R /W is to denote Read/Write if available from PLC program. 
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Uxy.00 

UXY.00 

Uxy.01 

 
 

 

 

5.2.1 Module Ready/Error (UXY.00, X: Base No., Y: Slot No. Z: Channel no.) 
 

(1) Uxy.00.F: It will be ON when PLC CPU is powered or reset with D/A conversion ready to process 
D/A conversion. 

(2) Uxy.00.0~3: It is a flag to display the error status of D/A conversion module for respective channels. 
 
 
 

B:bit 

  
Module Ready 

Bit ON (1): Ready, Bit Off (0): Not Ready 

Error information 
Bit ON (1): Error, Bit Off (0): Normal 

 

5.2.2 HART communication error 
(UXY.00, X: Base No., Y: Slot No. Z: Channel no.) 

(1) Detection sign of HART communication error for respective output channels is saved in UXY.00.8 ~ 
00.B. 

(2) Each bit will be set to 1 if an assigned channel is detected as HART communication error, and it will 
be back to 0 if HART communication back. In addition, each bit can be used to detect the HART 
communication error in the user program together with execution conditions. 

 
 
 

B:bit 
 

 
BIT Description 

0 HART communication normal 

1 HART communication error 

 
 
 
 
 

5.2.3 Channel operation information 
(UXY.00, X: Base No., Y: Slot No. Z: Channel no.) 

(1) This area is used to display the channel being used. 
 

 

B:bit 

 

Run channel information 
Bit On (1): During Run, Bit Off (0): Operation Stop 

5.2 I/O area of D/A Converted Data 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

R 

D 

Y 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 
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B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

C 

H 

3 

L 

C 

H 

3 

H 

C 

H 

2 

L 

C 

H 

2 

H 

C 

H 

1 

L 

C 

H 

1 

H 

C 

H 

0 

L 

C 

H 

0 

H 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

     Channel# digital input value      

 

UXY.00 

Uxy.02 

Uxy.03 ~ Uxy.6 

5.2.4 Flag to detect output limit 
(UXY.00, X: Base No., Y: Slot No. Z: Alarm bit according to channel.) 

 
(1) Detection sign of output limit for respective output channels is saved in UXY.01.8 ~ 01.F. 
(2) Each bit will be set to 1 if an assigned channel is detected as output limit alarm, and it will be back to 

0 if output limit alarm back. In addition, each bit can be used to detect the output limit in the user 
program together with execution conditions. 

 

 

 

 

BIT Description 

0 Meet setting range 

1 Exceed setting range 

 

 
5.2.5 Output setting (UXY.00, X: Base No., Y: Slot No. Z: Channel no.) 

 
(1) Enable/Disable D/A output can be specified for respective channels. 
(2) If the output is not specified, output of all the channels will be disabled. 
(3) Enable/Disable D/A output is as specified below. 

 

B:bit 
 

Run channel information 

Bit ON (1): Enable, Bit Off (0): Disable 

 

 

5.2.6 Digital input (UXY.00, X: Base No., Y: Slot No. Z: Channel no.) 
 

(1) Digital input value can be selected and used within the range of -192~16191, -8192~8191, 
3808~20192 or -120~10191 for 4 ~ 20mA based on input type. 

(2) If the digital input value is not specified, it will be set to 0. 
 
 

B:bit 

 

Address Details 

3 CH0 digital output value 

4 CH1 digital output value 

5 CH2 digital output value 

6 CH3 digital output value 
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Address “0” 

 

 

5.3.1 Specifying channels to use (Address no.0) 
 

If the channel to use is not specified, all the channels will be set to disable. 
 

 

B:bit 

 

 

BIT Details 

0 Stop 

1 Run 

 
 
 

5.3.2 Setting Output Current range (Address no.1) 
 

(1) The range of analog output can be specified for respective channels. 
(2) If the output range is not specified, the range of all the channels will be set to 4~20 mA for current 

output. 
(3) Setting of output range is as specified below. 

 
 B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 

 
— 

 
— 

 
— 

 
— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

Address “1” 

B:bit 
 

 

 
BIT Details 

00 4 ~ 20mA 

01 0 ~ 20mA 

5.3 Operation Parameters Settings 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 
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— 

 
— 
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H 

1 

C 

H 

0 
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B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

      Channel# Setting value       

 

Address “2” 

Address “3~6” 

 

 

5.3.3 Specifying Input data type (Address no.2) 
 

(1) Input type can be specified for respective channels. 
(2) If input type is not specified, all the channels will be set to the range of 0~16000. 

 
 
 

B:bit 

 

 
BIT Details 

00 0 ~ 16000 

01 -8000 ~ 8000 

10 Precise Value 

11 0 ~ 10000 

 

(3) This area is used to specify D/A input type for respective channels. 
The precise value has the digital input ranges as follows; 

 

Analog output 
Digital input 4 ~ 20mA 0 ~ 20mA 

Precise Value 4000 ~ 20000 0 ~ 20000 

 
 

5.3.4 Setting Output type (Address no.3 ~ 6) 
 

Based on setting value, the output status is as follows. 
 

 

B: bit 

 

 
Setting value Details 

0 Keeps the previous value as it is 

1 Outputs the minimum value of output range 

2 Outputs the middle value of output range 

3 Outputs the maximum value of output range 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
— 
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H 

3 
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H 
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1 

C 

H 

0 
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B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

— — — — — — — — Channel# Error code 

 
Address “11~14” 

 

 

5.3.5 Error code (Address no.11 ~ 14) 
 

Error codes detected from HART analog output module will be saved. 
 

 

Refer to the table below for detailed error codes 
 

Error Code 
(Dec) 

Details 
RUN 
LED 

ALM 
LED 

10 Module error (Reset Check Error)  
Blinks 
every 
0.2 
sec. 

 
 

Off 

11 Module error (Ram Check Error) 

12 Module error (Register Check Error) 

13 Module error (E2PROM Check Error) 

21 Module error (D/A Conversion Error) 

31# Note) Current module’s parameters setting error  

Blinks 
every 
1 sec. 

 
 

Off 
32# Note) Parameters setting error when setting current module’s Offset/Gain 

 
40# Note) 

Setting error of current module’s digital input range 

(If input value is set less than -192, or greater than 16191) 

The range changes based on input type 

 

60# Note) 
Compare error of output limit H/L value 

(If output limit low value is set greater than output limit high value) 

 
 

On 

 

Blinks 
every 
1 sec. 

 
70# Note) 

Setting error of change rate control setting 

(If change rate control setting value is set greater than input range 

value) 

 

Note) # (0~3) stands for the channel with error found. 
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B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

     CH# High/Low output limit      

 

Address “19” 

Address “20~27” 

 

5.3.6 Output limit setting (Address no.19) 
 

The Output limit setting is not used, all channels is set by Disable. 
 

 

B:bit 

 

 

BIT Description 

0 Disable 

1 Enable 

 
 

5.3.7 CH0 High/Low output limit setting (Address no.20 ~ 27) 
 

(1) The value of high/low output limit can be set when output limit setting is set to ‘Enable’. 
(2) The value of high/low output limit can be set within -192~16191. 
(3) The value of high output limit should be greater than the value of low output limit. 

 
 

B:bit         

 

Address Description 

20 CH0 High output limit 

21 CH0 Low output limit 

22 CH1 High output limit 

23 CH1 Low output limit 

24 CH2 High output limit 

25 CH2 Low output limit 

26 CH3 High output limit 

27 CH4 Low output limit 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 
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0 
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B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

    CH# increase/Decrease limit value      

 

Address “28” 

Address “29~36” 

 

5.3.8 Rate control setting (Address no.28) 
 

All channels are to set ‘Disable’ when rate control setting is not set. 
 

 

B:bit 

 

 

BIT Description 

0 Disable 

1 Enable 

 
 
 
 
 
 
 
 
 

 

5.3.9 Increase/Decrease limit value setting (Address no.29 ~ 36) 
 

(1) Increase/Decrease limit value can be set when rate control setting is to set ‘Enable’. 
(2) Increase/Decrease limit value can be set within 0~16000. 

 

B:bit         

 

Address Description 

29 CH0 increase limit value 

30 CH0 decrease limit value 

31 CH1 increase limit value 

32 CH1 decrease limit value 

33 CH2 increase limit value 

34 CH2 decrease limit value 

35 CH3 increase limit value 

36 CH3 decrease limit value 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
— 

 
— 

 
— 
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0 
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Address “40” 

 

5.3.10 HART communication Enable/disable (Address no.40) 

(1) If the channel to use is not specified, all the channels will be set to Disabled 

(2) HART communication is possible to set in the range of 4 ~ 20㎃ only. 

 

 

B:bit 

 
 

 
BIT Details 

0 Disable 

1 Enable 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 
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Chapter 5 Configuration and Function of Internal Memory (For 2MLK) 

5 - 13 

 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

    HART communication error count     

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

CH# HART communication status   CH# field device status  

 

Address “68~71” 

Address “72~75” 

 
 

 
 

5.4.1 HART communication error count(Address 68 ~ 71) 

(1) Count of HART communication errors can be monitored. 
(2) Communication error count is accumulated for each channel and up to 65,535 is displayed. 
(3) Even though HART communication is recovered, error count maintains its status. 

 
 

Exceed 65,535 counts start from zero again.  
 

Address Details 

68 CH0 HART communication error count 

69 CH1 HART communication error count 

70 CH2 HART communication error count 

71 CH3 HART communication error count 

 

 

5.4.2 Communication/field device status(Address 72 ~ 75) 

(1) Status of HART communication and field devices can be monitored. 
(2) Top byte shows HART communication status while lower byte shows field device status. 
(3) For details on each status, refer to (4) and (5). 

 

For details on each status, refer to Hexadecimal code  

 

 

Address Details 

72 CH0 communication/field device status 

73 CH0 communication/field device status 

74 CH0 communication/field device status 

75 CH0 communication/field device status 
 

(4) Status of HART communication 

 
 Bit Code(Hexadecimal)) Details  

7 - Communication error 

6 C0 Parity error 

5 A0 Overrun error 

4 90 Framing error 

3 88 Checksum error 

2 84 0(reserved) 

1 82 Receiving buffer overflow 

0 81 0(reserved) 

5.4 HART Commands Information Area 

※ Hexadecimal value is shown, including the 7th bit. 
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B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 
— 
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— 

 
— 

 
— 
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0 

 

Address “76” 

 

(5) Status of field device 

Bit Code(hexadecimal) Content 

7 80 Field device malfunction 

6 40 
Configuration changed: This bit is set when the field 

device’ s environment configuration is changed. 

5 20 
Cold Start: This bit is set when power failure or device reset 

takes place. 

4 10 
More status available: It shows that more information can be 

obtained through No.48 command. 

3 08 
Analog output fixed: It shows that a device is in the Multidrop 

mode or output is set to a fixed value for test. 

 
2 

 
04 

Analog output saturated: It shows that analog output is not 

changed since it is measured to be the upper limit or lower 

limit. 

 
1 

 
02 

Primary Variable Out of Limits: It means that PV measuring 

value is beyond the sensor operation range. Therefore, the 

measuring cannot be reliable. 

 
0 

 
01 

Non-primary Variable Out of Limits): It means that non-

primary variable‘ s measuring value is beyond the operation 

range. Therefore, the measuring cannot be reliable. 

 

 

5.4.3 Select to retain data in case of HART communication error (Address 76) 
 

(1) In case of HART communication error, it is possible to set whether to retain existing 
communication data. 

(2) Default value is set to retain existing communication data. 
(3) If Enable is set, HART communication response data will be cleared in case of HART 

communication error. 
 

 

 

 
 

BIT Details 

0 Disable 

1 Enable 
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6.1 Internal Memory Read/Write 

 

Chapter 6 Programming (For 2MLK) 
 

 

6.1.1 Read of internal memory (GET, GETP instruction) 
 
 

 
Command 

Area available  
Step 

Flag 

PMK F L T C S Z D.x R.x 
Cons 

tant 
U N D R 

Error 

(F110) 

Zero 

(F111) 

Carry 

(F112) 

 

GET(P) 

sl - - - - - - - - - ○ - - - -  

4~7 

 

- 

 

- 

 

- 
S - - - - - - - - - ○ - - - - 

D ○ - ○ - - - - - - - ○ ○ ○ ○ 

N ○ - ○ - - - - - - ○ ○ ○ ○ ○ 
 

 
GET 

 

 

 

GETP 

 

 

 = GET 

 

[Area Setting] 

Operand Description 
Data 
size 

sl Slot number mounted to the special module WORD 

S Channel number of the special module WORD 

D Top address to save the data WORD 

N Number of words to be read WORD 

 
[Flag Set] 

Flag Content Device No. 

PUT/GET 
error 

- The special module is not mounted to a designated slot or it is 
mounted to other module 

- PUT/GET command did not execute properly. 

 

F0015~F0022 

 

If HART analog output module is installed on base No.0 and slot No.3, and internal 

memory address No.0 & 1’s data in module is read to D16 and D17 of CPU module. 

 
 

Address D area of CPU module 
 Internal memory of D/A 

conversion module 
Address 

D00015   

 
 

 
 

  

D00016 Run channel setting Run channel setting 0 

D00017 Range of output current Range of output current 1 

D00018   2 

D00019   3 

Example 
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6.1.2 Write of internal memory (PUT, PUTP instruction) 
 
 

 
Command 

Area available  
Step 

Flag 

PMK F L T C S Z D.x R.x 
Cons 

tant 
U N D R 

Error 

(F110) 

Zero 

(F111) 

Carry 

(F112) 

 

PUT(P) 

sl - - - - - - - - - ○ - - - -  

4~7 

 

- 

 

- 

 

- 
S - - - - - - - - - ○ - - - - 

D ○ - ○ - - - - - - - ○ ○ ○ ○ 

N ○ - ○ - - - - - - ○ ○ ○ ○ ○ 
 

 
PUT 

 

 

 

PUTP 

 

 

 = PUT 

 
[Area Setting] 

Operand Description 
Data 
size 

sl Slot number mounted to the special module WORD 

S Channel number of the special module WORD 

D Top address to save the data WORD 

N Number of words to be read WORD 

 
[Flag Set] 

Flag Content Device No. 

PUT/GET 
error 

- The special module is not mounted to a designated slot or it is 
mounted to other module 

- PUT/GET command did not execute properly. 

 

F0015~F0022 

 
If D/A conversion module is installed on Base No.0 and Slot No.6, and CPU module’s data 

of D16~D17 is written on internal memory addresses 0~1 of D/A conversion module, 

 

Address D area of CPU module 
Internal memory of D/A 

conversion module 

 

Address 

 

D00015 

D00016 0 

D00017 1 

D00018 2 

D00019 3 

Example 

  

Data 1 
 

Data 2 
 

 

 

 

 

Run channel setting 

Range of output current 
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6.1.3 HART commands 
 

(1) Commands form 

No. Name Details 
EXECution 

condition 
Form 

 
1 

 
HARTCMND 

Write HART 

commands 

 
Pulse 

 

 

 
2 

 
HARTRESP 

 

HART 

response 

 
Level 

 

 

 
3 

 
HARTCLR 

 

Clear HART 

commands 

 
Pulse 

 

 

 
(2) Error content 

Error Content HARTCMND HARTRESP HARTCLR 

No module is on the designated slot O O O 

Or more 4 is set to operand S O O O 

Other numbers than HART command numbers are set to operand 

channel(ch) 

HART command number: 0, 1, 2, 3, 12, 13, 15, 16, 48, 50, 57, 61, 

110 

 

 
Not applicable 

 

 
O 

 

 
Not applicable 

The device set to operand D is beyond the area 

Total 30 words starting from the device used as operand are 

beyond the maximum settable area. 

 

Not applicable 

 

O 

 

Not applicable 
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COMMAND 

HARTCMND HARTCMND sl ch S D 

 

6.1.4 HARTCMND command 

 
 

command 

Area available  
step 

Flag 

PMK F L T C S Z D.x R.x Constant U N D R 
Error 

(F110) 

Zero 

(F111) 

Carry 

(F112) 

 

HARTCMND 

sl - - - - - - - - - ○ - - - -  

- 

 

○ 

 

- 

 

- 
ch - - - - - - - - - ○ - - - - 

S ○ - - - - - - - - ○ - - ○ - 

D ○ - - - - - - - - - - - ○ - 

 

 
[Area Setting] 

Operand Description 
Operand 

type 

Valid 

size 

Data 

size 

sl Slot number mounted to the special module Data Integer Word 

ch Channel number of the special module Data Integer Word 

S 
HART communication command setting (each bit shows each 
HART command) 

Data 
Integer 
(13bit) 

Word 

D 
HART command setting status(The currently set commands are 
combined and written for each bit) 

Address Integer Word 

- Set of operand S 
 

► HART command numbers 
 

B15 B14 B13 B12 B11 B10 B9 
B8 

B7 B6 B5 B4 B3 B2 B1 B0 

 
— 

 
— 

 
— 

 
100 

 
61 

 
57 

 
50 

 
48 

 
16 

 
15 

 
13 

 
12 

 
3 

 
2 

 
1 

 
0 

 

 

 

- Monitoring of operand D 

Command is executed when corresponding bit set on 

Bit information of the currently set commands is displayed. 
For example, Bit 1 and 2 are displayed on D device if bit 1 and bit 2 are set. 

[Flag Set] 

 
 
 
 
 

[Example program] 

 
 

Notes  

HARTCMND command or HARHCLR command is executed by setting bit of a corresponding command while 
HARTRESP command is set by inputting a command number. 
For example, if command 57 is executed, enter H0400 (K1024) to operand S for HARTCMND command or 
HARHCLR command and enter command K57 to operand S for HARTRESP command. Here, H0400 is a 
hexadecimal to set bit10- command 57. 

Flag Content Device No. 

 

Error 
- The special module is not mounted to a designated slot or it is mounted to 
other module 

- A value inputted to a channel exceeds the range(0~3) set to the channel 

 

F110 
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COMMAND 

HARTRESP    
HARTRESP sl ch S D 

 

6.1.5 HARTRESP command 
 
 

 
command 

Area available  
step 

Flag 

PMK F L T C S Z D.x R.x constant U N D R 
Error 

(F110) 

Zero 

(F111) 

Carry 

(F112) 

 

HARTRESP 

sl - - - - - - - - - ○ - - - -  

- 

 

○ 

 

- 

 

- 
ch - - - - - - - - - ○ - - - - 

S ○ - - - - - - - - ○ - - ○ - 

D ○ - - - - - - - - - - - ○ - 
 

[Area setting] 

Operand Description 
Operand 

type 
Valid 
size 

Data 
size 

sl Slot number mounted to the special module Data Integer Word 

ch Channel number of the special module Data Integer Word 

S HART command number Data 2byte Word 

D Start address of a device that will display response Address 2byte Word 

- Operand S sets a command number to receive HART communication response. 
(0, 1, 2, 3, 12, 13, 15, 16, 48, 50, 57, 61, 110) 

- 30 words are assigned to D operand when implementing Read Command. 

For example, when M2030 is designated on 2MLK-CPUH, an error takes place because M2040 is 
not sufficient for the maximum 30 Words. 

- For details on each command, refer to Appendix 2 HART commands. 

[Flag Set] 

 
 
 
 
 
 

 
[Example program] 

 

Flag Description Device No. 

 

 
Error 

- The special module is not mounted to a designated slot or it is mounted to 
other module 

- A value inputted to a channel exceeds the range(0~3) set to the channel 
- A command designated to S is other than 0, 1, 2, 3, 12, 13, 15, 48, 50, 57, 
61, 110 

- A device designated to D exceeds the device area (30 Words) 

 

 
F110 
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COMMAND 

HARTCLR    
HARTCLR sl ch S D 

 

6.1.6 HARTCLR command 
 
 

 
command 

Area available  
step 

Flag 

PMK F L T C S Z D.x R.x constant U N D R 
Error 

(F110) 

Zero 

(F111) 

Carry 

(F112) 

 

HARTCLR 

sl - - - - - - - - - ○ - - - -  

- 

 

○ 

 

- 

 

- 
Ch - - - - - - - - - ○ - - - - 

S ○ - - - - - - - - ○ - - ○ - 

D ○ - - - - - - - - - - - ○ - 
 

[Area setting] 

operand Description 
operand 

type 

Valid 

size 

data 

size 

sl Slot number mounted to the special module Data Integer Word 

ch Channel number of the special module Data Integer Word 

S HART communication command setting (each bit shows each 
HART command) 

Data 
13bit Word 

D 
HART command setting status(The currently set commands are 
combined and written for each bit) 

Address 2byte Word 

- Setting method is the same with that of HARTCMND command. But, it plays a role in cancelling other 
commands set differently from HARTCMND command. 

[Flag Set] 

Flag Description Device No. 

 
Error 

- The special module is not mounted to a designated slot or it is mounted to 
other module 

- A value inputted to a channel exceeds the range(0~3) set to the channel 

 
F110 

 
[Example program] 

 
 

 
 

 

TIP 

• If [Monitor] -> [Monitor Special Module] -> [Start Monitor] works on SoftMaster either in 
CPU STOP or RUN mode, ‘h0003’ is saved in HART command (HARTCMND). 

• If [Monitor] -> [Monitor Special Module] -> [HART Device Information] -> [Read] works 
under the same condition with (1), ‘h00F1’ is saved in HART command (HARTCMND). 

• If [Monitor] -> [Monitor Special Module] -> [Start Monitor] -> [HART Device 
Information] -> [Read] works under the same condition with (1), ‘h00F3’ is saved in 
HART command (HARTCMND). 

Therefore, use HARTCLR command to delete HART command values. 
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(1)  How to specify Run condition details of HART analog output module’s internal memory will be 
described. 

(2) HART analog output module is as installed on slot 1. 
(3) I/O assigned points of HART analog output module is 16 points. 

 
6.2.1 Basic program of 2MLF-DC4H 

(1) Program example through [I/O parameter] setting 

 

 

Module Ready Digital value to output 
 

All CH output enable 

CH0 digital value Write 

CH1 digital value Write 

CH2 digital value Write 

CH3 digital value Write 

6.2 Basic Program 

CH Run information 
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(2) Program example with PUT/GET instruction used 
 

 

 
Slot No. 

Internal 
Memory 
address 

 
Setting 

data 

The number 
of data 
to write 

 

Used CH(CH0.1.2.3) 

 
Output range(4~20mA) 

Data type (0~16000) 

CH output status setting 
0,1,2,3:Output previous value 

All CH output allowed 

CH0 digital value Write 

CH1 digital value Write 

CH2 digital value Write 

CH3 digital value Write 

Module Ready 

CH operation 
contact 

CH Run information 
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6.3.1 Inverter speed control 

(1) System Configuration 

 

 
 

(2) Details of initial setting 
 

No Parameters Setting Details Internal Memory Address 

1 Channels CH 0 0 

2 Output voltage range 0 ~ 20 ㎃ 1 

3 Data type 0 ~ 16,000 2 

4 Channel Output type Previous value 3 

 

(3) Description of program 
 

(a) At the same time Module Ready Contact is On, output of all the channels will be set to Allowed. 

(b) If P0001 is On, 0 ㎃ will be output. 

(c) If P0002 is Off and P0002 is On, 5 ㎃ will be output. 

(d) If P0003 is Off and P0003 is On, 10 ㎃ will be output. 

(e) If P0004 is Off and P0004 is On, 15 ㎃ will be output. 

6.3 Application Program 
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Execution 
contact 

 

(4) Program 
 

(a) Program example through I/O Parameters Setting. 
 

 

(b) Program 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Module Ready 
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(c) Program example with PUT/GET instruction used 
 

 
Setting data 

 

 
 

6.3.2 BCD output of error code 

 
(1) System Configuration 

(2) Details of initial setting 

a) Used CH: CH 0, 1 

b) Analog output current range: DC 4 ~ 20 mA 

c) Digital input data range: 0 ~ 16000 

d) HART communication : CH1 
 
 
 
 
 
 

Internal memory 

address 

Slot No. 

The number of 
data to write 

Module Ready 
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(3) Description of program 

a) If P00000 is On, D/A conversion will be initially specified. 
b) If P00001 is On, save 8000 on channel0 output value and D00001 on error code. 
c) If P00002 is On, applicable error code will be output to digital BCD display. (P00040 ~ P0004F) 
d) If P00003 is On, save 12000 on channel1 output value and check commands after reading 

HART command 12 message. 

 

(4) Program 
(a) Program example through [I/O Parameter] setting. 

 

Module READY 
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(b) Program example with PUT/GET instruction used 
 

 
Module READY 
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- executing HART command 0 on channel 1 
 

* Preamble: 5~20 byte hexadecimal FF is used in HART communication that uses characters, symbols or 
Frequency Shift Keying(FSK) to help synchronizing with receiving at the first part of HART message. 

 

- executing HART command 2 on channel 1 
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7.1 Global Variable (Data area) 

 
 

Chapter 7 Configuration and Function of Global Variable 
(For 2MLI/2MLR) 

 

 

7.1.1 IO area configuration of HART analog output module 

Indicates D/A conversion data IO area at table 7.1 
 

[Table 7. 1] A/D conversion data IO area 

Global variable 
Memory 

allocation 
Contents Read/Write 

_xxyy_CH0_ERR %UXxx.yy.0 CH0 error  

_xxyy_CH1_ERR %UXxx.yy.1 CH1 error  

_xxyy_CH2_ERR %UXxx.yy.2 CH2 error  

_xxyy_CH3_ERR %UXxx.yy.3 CH3 error  

.. .. ..  

_xxyy_CH0_HARTERR %UXxx.yy.8 CH0 HART communication error Read 
_xxyy_CH1_HARTERR %UXxx.yy.9 CH1 HART communication error  

_xxyy_CH2_HARTERR %UXxx.yy.10 CH2 HART communication error  

_xxyy_CH3_HARTERR %UXxx.yy.11 CH3 HART communication error  

.. .. ..  

_xxyy_RDY %UXxx.yy.15 Module READY flag  

_xxyy_CH0_ACT %UXxx.yy.16 CH0 run flag  

_xxyy_CH1_ACT %UXxx.yy.17 CH1 run flag  

_xxyy_CH2_ACT %UXxx.yy.18 CH2 run flag  

_xxyy_CH3_ACT %UXxx.yy.19 CH3 run flag  

.. .. ..  

_xxyy_CH0_OUTH %UXxx.yy.24 CH0 output high limit detection flag  

_xxyy_CH0_OUTL %UXxx.yy.25 CH0 output low limit detection flag Read 
_xxyy_CH0_OUTH %UXxx.yy.26 CH1 output high limit detection flag  

_xxyy_CH0_OUTL %UXxx.yy.27 CH1 output low limit detection flag  

_xxyy_CH0_OUTH %UXxx.yy.28 CH2 output high limit detection flag  

_xxyy_CH0_OUTL %UXxx.yy.29 CH2 output low limit detection flag  

_xxyy_CH0_OUTH %UXxx.yy.30 CH3 output high limit detection flag  

_xxyy_CH0_OUTL %UXxx.yy.31 CH3 output low limit detection flag  

_xxyy_OUTEN %UWxx.yy.2 Output status setting  
 
 

 
Write 

_xxyy_CH0_OUTEN 
_xxyy_CH1_OUTEN 
_xxyy_CH2_OUTEN 
_xxyy_CH3_OUTEN 

%UXxx.yy.31 
%UXxx.yy.32 
%UXxx.yy.33 
%UXxx.yy.34 

CH0 output enable 
CH1 output enable 
CH2 output enable 
CH3 output enable 

_xxyy_CH0_DATA %UWxx.yy.3 CH0 Digital input value 

_xxyy_CH1_DATA %UWxx.yy.4 CH1 Digital input value 

_xxyy_CH2_DATA %UWxx.yy.5 CH2 Digital input value 

_xxyy_CH3_DATA %UWxx.yy.6 CH3 Digital input value 
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(1) In the device allocation, xx means base number where module is installed and yy means base 
number where module is installed. 

(2) To read ‘CH0 digital input value’ of HART Analog Output Module installed at base 0, slot 4, 
expression is %UW0.4.3. 

 

Base No. 
 

 
%UW 0 

 

 

Dot 
 
 

. 

 

 

Dot 
 
 

4 . 3 
 

  
Device Type  

Slot No. 

WORD 

 

(3) To read ‘CH3 output low limit detection flag’ of Analog Input Module installed at base 0, slot 5, 
expression is %UX0.5.31. 
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7.1.2 How to use global variable 

In order to register global variable, there are two method, auto registration after setting I/O parameter at 

project window and batch registration after setting I/O parameter 

 

In order to register global variable, there are two method, auto registration after setting I/O parameter at 
project window and batch registration after setting I/O parameter. 

1. I/O parameter registration 

− Registers module you want to use at I/O parameter 

a) Double-click I/O parameter of project window 

b) Select 2MLF- DC4H module at I/O parameter window 

c) Set parameter by pressing [Details] and select [OK] 

d) Select [Yes] 

− Auto-register global variable of module set in I/O parameter 

e) Global variable auto registration check 

− Double-click Global/Direct Variable of project window 

2. Global variable registration 

− Registers global variable set in I/O parameter 

a) Double-click Global/Direct Variable of project window 

b) Select [Register Special Module Variables] at menu [Edit] 

3. Local variable registration 

− Registers variable among registered global variable you want to use as local variable. 

a) Double-click local variable to use in the following scan program. 

b) Click  right button of mouse in the right local variable window and select “Add EXTERNAL 
variable”. 

c) Select local variable to add at Global View on “Add External Variable” window (“All” or “Base, 
slot”). 

• View All 

• View per base, slot 

a) The following is an example for selecting digital input value (_0000_CH0_DATA) 
of “Base00, Slot01”. 
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(1) Global variable registration 

- Registers global variable set in I/O parameter 

(a) Double-click Global/Direct Variable of project window 

 

 
(b) Select [Register Special Module Variables] at menu [Edit] 
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4. How to use local variable on program 

− It describes the added global variable at local program. 

− The following is an example for getting the conversion value of CH0 of 
Analog Input Module to %MW0. 

a) At part reading A/D conversion data to %MW0 by using the following 
MOVE function, double-click variable part ahead of IN, then “Select 
Variable” window shows up. 

 

 

b) Select global variable at variable type at Select Variable window. And 
select relevant base (0 base, 0 slot) at global variable view item. 

c) Double-click or select _0000_CH0_DATA corresponding to CH0 
A/D conversion data and click [OK]. 

d) The following figure is result adding global variable corresponding to 
CH0 A/D conversion value. 
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-View All 

 
 

- View per base, slot 

 
 

(c) The following is example selecting digital input value (_0000_CH0_DATA) of “Base00, Slot01”. 
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7.2.1 PUT/GET Function Block use area (Parameter area) 

It indicates operation parameter setting area of HART Analog Output Module at table 7.2. 

[Table 7. 2] Operation parameter setting area 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

※ At device allocation, xx means base number and yy means slot number where module is equipped. 

7.2 PUT/GET Function Block use area (Parameter area) 

Global variable Contents R/W Instruction 

_Fxxyy_CH_EN 
_Fxxyy_OUT_RANGE 
_Fxxyy_DATA_TYPE 

Set alarm process 
Set average process method 
Set channel to use 

 
R/W 

 
PUT 

_Fxxyy_CH0_STAT 
_Fxxyy_CH0_HI_LIMIT 
_Fxxyy_CH0_LOW_LIMIT 
_Fxxyy_CH0_INC_RATE 
_Fxxyy_CH0_DEC_RATE 

CH0 output status setting 
CH0 output high limit 
CH0 output low limit 
CH0 change rate increase value 
CH0 change rate decrease value 

 
 

R/W 

 
 

PUT 

_Fxxyy_CH0_STAT 
_Fxxyy_CH0_HI_LIMIT 
_Fxxyy_CH0_LOW_LIMIT 

_Fxxyy_CH0_INC_RATE 
_Fxxyy_CH0_DEC_RATE 

CH0 output status setting 
CH0 output high limit 
CH0 output low limit 
CH0 change rate increase value 
CH0 change rate decrease value 

 
 

R/W 

 
 

PUT 

_Fxxyy_CH0_STAT 
_Fxxyy_CH0_HI_LIMIT 
_Fxxyy_CH0_LOW_LIMIT 
_Fxxyy_CH0_INC_RATE 
_Fxxyy_CH0_DEC_RATE 

CH0 output status setting 
CH0 output high limit 
CH0 output low limit 
CH0 change rate increase value 
CH0 change rate decrease value 

 
 

R/W 

 
 

PUT 

_Fxxyy_CH0_STAT 
_Fxxyy_CH0_HI_LIMIT 
_Fxxyy_CH0_LOW_LIMIT 
_Fxxyy_CH0_INC_RATE 
_Fxxyy_CH0_DEC_RATE 

CH0 output status setting 
CH0 output high limit 
CH0 output low limit 
CH0 change rate increase value 
CH0 change rate decrease value 

 
 

R/W 

 
 

PUT 

_Fxxyy_LIMIT_EN 
_Fxxyy_RATE_EN 
_Fxxyy_HART_EN 

Channel output limit setting 
Channel change rate control setting 
HART communication setting 

 

R/W 
 

PUT 

_Fxxyy_CH0_ERR 
_Fxxyy_CH1_ERR 
_Fxxyy_CH2_ERR 
_Fxxyy_CH3_ERR 

CH0 error code 
CH1 error code 
CH2 error code 
CH3 error code 

 
R 

 
GET 
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7.2.2 PUT/GET instruction 

(1) PUT instruction 

 

PUT 
 

Writing data to special module 

 

Function Block Description 

 
 

PUT 

BOOL REQ DONE BOOL 

USINT BASE STAT UINT 

USINT SLOT 

UINT MADDR 

*ANY DATA 

Input 

REQ : EXECute function when 
1 BASE : Specify base position 
SLOT : Specify slot position 
MADDR : Module address 
DATA : Data to save module 

 

Output 
DONE : Output 1 when normal 
STAT : Error information 

*ANY: WORD, DWORD, INT, USINT, DINT, UDINT type available among ANY type 

 
■ Function 

Read data from designated special module 

 
Function 

Block 
Input(ANY) type Description 

PUT_WORD WORD 
Save WRD data into the designated module address 
(MADDR). 

PUT_DWORD DWORD 
Save DWORD data into the designated module address 
(MADDR). 

PUT_INT INT 
Save INT data into the designated module address 
(MADDR). 

PUT_UINT UINT 
Save UNIT data into the designated module address 
(MADDR). 

PUT_DINT DINT 
Save DINT data into the designated module address 
(MADDR). 

PUT_UDINT UDINT 
Save UDINT data into the designated module address 
(MADDR). 
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(2) GET instruction 

 

GET 
 

Reading from special module data 

 

Function block Description 

 
 
 
 

GET 

BOOL REQ DONE BOOL 

USINT BASE STAT UINT 

USINT SLOT DATA *ANY 

UINT MADDR 

Input 

REQ : EXECute function when 
1 BASE : Specify base position 
SLOT : Specify slot position 
MADDR : Module address 

512(0x200) ~ 1023(0x3FF) 
 

Output 
DONE : Output 1 when normal 
STAT : Error information 
DATA : Data to read from module 

*ANY: WORD, DWORD, INT, UINT, DINT, UDINT type available among ANY type 

 
■ Function 

Read data from designated special module 

 

Function Block Output(ANY) type Description 

GET_WORD WORD 
Read data as much as WORD from the designated module 
address (MADDR). 

GET_DWORD DWORD 
Read data as much as DWORD from the designated module 
address (MADDR). 

GET_INT INT 
Read data as much as INT from the designated Module 
address (MADDR). 

GET_UINT UINT 
Read data as much as UNIT from the designated module 
address (MADDR). 

GET_DINT DINT 
Read data as much as DINT from the designated module 
address (MADDR). 

GET_UDINT UDINT 
Read data as much as UDINT from the designated module 
address (MADDR). 
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7.2.3 HART Commands 

 
(1) HART_CMND command 

 

HART_CMND 
 

Writing HART command to module 

 

Function Block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 
C_SET 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 
: Communication command to be written (bit mask 

set) 

Output 
 

DONE 
STAT 

: Output 1 when normal 
: Error information 

 

■ Function 

(a) It is used to set a command to be communicated regarding to the designated module’s channel. 
(b) Set bit(BOOL Array) corresponding to a command to be communicated on “C_SET”. 

Command 110 61 57 50 48 16 15 13 12 3 2 1 0 

Array index 12 11 10 9 8 7 6 5 4 3 2 1 0 

(c) If “REQ” contact is converted from 0 to 1, function block will be executed. 
 

■Example program 
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(2) HART_C000 command 
 

HART_C000 

Read response to Universal Command 0 

 

Function block Description 

 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 

: Specify slot position 
: Used channel number 

Output 
 

DONE 
STAT 
M_ID 
D_TYP 

 
 

PAMBL 
U_REV 
D_REV 
S_REV 
H_REV 
DFLAG 
D_ID 

: Output 1 when normal 
: Error information 
: Manufacturer ID 
: Manufacturer’s device type code(If 4 

digits are displayed, the first two digits 
refer to manufacturer ID code) 

: Minimum Preamble number 
: Universal Command Revision 
: Device Specific Command Revision 
: Software Revision 
: Hardware Revision(x10) 
: Device Function Flag 
: Device ID 

 

■ Function 

When [Universal Command 0] command is set to the designated module’s channel, this function is 
used to monitor response data. If HART channel is set to ‘Allow’ and HART communication is 
normally performed, response data of this area will be displayed even though any response to 
Command 0 is requested through HART_CMND. But, to monitor those data continuously, set 
Command 0 command through HART_CMND. 
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■Example program 
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(3) HART_C001 Command 
 

HART_C001 

Read response to Universal Command 1 

 

Function block Description 
 

 

Input 
 

REQ : EXECute function when 1(rising edge) 
BASE : Specify base position 
SLOT : Specify slot position 

CH : Used channel number 

Output 
 

DONE : Output 1 when normal 
STAT : Error information 
PUNIT : Primary Variable Unit 

PV : Primary Variable 

 

 
■ Function 

When [Universal Command 1] command is set to the designated module’s channel, this function is 
used to monitor response data. 

 

■Example program 
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(4) HART_C002 command 
 

HART_C002 

Read response to Universal Command 2 

 

Function block Description 

 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 

 
Output 

 

DONE 
STAT 
CURR 
PCENT 

: Output 1 when normal 
: Error information 
: Primary Variable loop current(mA) 
: Primary Variable percent of range 

 

■ Function 

When [Universal Command 2] command is set to the designated module’s channel, this function is 
used to monitor response data. 

 

■Example program 
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(5) HART_C003 command 
 

HART_C003 

Read response to Universal Command 3 

 

Function block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 

Output 
 

DONE 
STAT 
CURR 
PUNIT 
PV 
SUNIT 
SV 
TUNIT 
TV 
QUNIT 
QV 

: Output 1 when normal 
: Error information 
: Primary Variable loop current(mA) 
: Primary Variable Unit 
: Primary Variable 
: Secondary Variable Unit 
: Secondary Variable 
: Tertiary Variable Unit 
: Tertiary Variable 

: Quaternary Variable Unit 
: Quaternary Variable 

 
 

■ Function 

When [Universal Command 3] command is set to the designated module’s channel, this function is 
used to monitor response data. 
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■Example program 
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(6) HART_C012 command 
 

HART_C012 

Read response to Universal Command 12 

 

Function block Description 
 

 

Input 
 

REQ : EXECute function when 1(rising edge) 

BASE : Specify base position 
SLOT : Specify slot position 

CH : Used channel number 

Output 
 

DONE : Output 1 when normal 

STAT : Error information 
MESS : Message(1/2) 

_AGE : Message(2/2) 

 

■ Function 

When [Universal Command 12] command is set to the designated module’s channel, this function is 
used to monitor response data. 

 

■Example program 
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(7) HART_C013 command 
 

HART_C013 

Read response to Universal Command 13 

 

Function block Description 
 

 

Input 
 

REQ : EXECute function when 1(rising edge) 

BASE : Specify base position 
SLOT : Specify slot position 

CH : Used channel number 

Output 
 

DONE : Output 1 when normal 
STAT : Error information 
TAG : Tag 
DESC : Descriptor 
YEAR : Year 
MON : Month 

DAY : Day 

 

■ Function 

When [Universal Command 13] command is set to the designated module’s channel, this function is 
used to monitor response data. 

 

■Example program 
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(8) HART_C015 command 
 

HART_C015 

Read response to Universal Command 15 

 

Function block Description 
 

 

Input 
 

REQ : EXECute function when 1(rising edge) 
BASE : Specify base position 
SLOT : Specify slot position 

CH : Used channel number 

Output 
 

DONE : Output 1 when normal 

STAT : Error information 
A_SEL : PV Alarm select code 
TFUNC : PV transfer function code 
RUNIT : PV range units code 
UPPER : PV upper range value 
LOWER : PV lower range value 
DAMP : PV damping value(sec) 
WR_P : Write-protect code 

DIST : Private-label distributor code 

 

■ Function 

When [Universal Command 15] command is set to the designated module’s channel, this function is 
used to monitor response data. 
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■Example program 
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(9) HART_C016 command 
 

HART_C016 

Read response to Universal Command 16 

 

Function block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 

Output 
 

DONE 
STAT 
FASSM 

: Output 1 when normal 
: Error information 
: Final assembly number 

 

■ Function 

When [Universal Command 16] command is set to the designated module’s channel, this function is 
used to monitor response data. 

 

■Example program 
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(10) HART_C048 command 
 

HART_C048 

Read response to Common Practice Command 48 

 

Function block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 

Output 
 

DONE 
STAT 
DSS1A 
DSS1B 
EXTD 
OPMD 
AOS 
AOF 
DSS2A 
DSS2B 
DSS2C 

: Output 1 when normal 
: Error information 
: Device-specific status1(1/2) 
: Device-specific status1(2/2) 

: Extend device-specific status(V6.0) 
: Operational modes(V5.1) 
: Analog outputs saturated (V5.1) 
: Analog outputs fixed (V5.1) 
: Device-specific status2(1/3) 
: Device-specific status2 (2/3) 
: Device-specific status2 (3/3) 

 

■ Function 

When [Common Practice Command 48] command is set to the designated module’s channel, this 
function is used to monitor response data. 
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■Example program 
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(11) HART_C050 Command 
 

HART_C050 

Read response to Common Practice Command 50 

 

Function block Description 

 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 

 
Output 

 

DONE 
STAT 
P_VAR 
S_VAR 
T_VAR 
Q_VAR 

: Output 1 when normal 
: Error information 
: Primary Device Variable 
: Secondary Device Variable 
: Tertiary Device Variable 
: Quaternary Device Variable 

 

■ Function 

When [Common Practice Command 50] command is set to the designated module’s channel, this 
function is used to monitor response data. 

 

■Example program 
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(12) HART_C057 command 
 

HART_C057 

Read response to Common Practice Command 57 

 

Function block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 

Output 
 

DONE 
STAT 
U_TAG 
UDESC 
UYEAR 
U_MON 
U_DAY 

: Output 1 when normal 
: Error information 
: Unit tag 
: Unit descriptor 

: Unit year 
: Unit month 
: Unit day 

 

■ Function 

When [Common Practice Command 57] command is set to the designated module’s channel, this 
function is used to monitor response data. 

 

■Example program 
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(13) HART_C061 command 
 

HART_C061 

Read response to Common Practice Command 61 

 

Function block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 

: Specify slot position 
: Used channel number 

Output 
 

DONE 
STAT 
AUNIT 
A_LVL 
PUNIT 
PV 
SUNIT 
SV 
TUNIT 
TV 
QUNIT 
QV 

: Output 1 when normal 
: Error information 
: PV Analog Output units code 
: PV Analog Output level 
: Primary Variable units code 
: Primary Variable 
: Secondary Variable units code 
: Secondary Variable 
: Tertiary Variable units code 
: Tertiary Variable 
: Quaternary Variable units code 
: Quaternary Variable 

 

■ Function 

When [Common Practice Command 61] command is set to the designated module’s channel, this 
function is used to monitor response data. 
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■Example program 
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(14) HART_C110 command 
 

HART_C110 

Read response to Common Practice Command 110 

 

Function block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 

: EXECute function when 1(rising edge) 
: Specify base position 

: Specify slot position 
: Used channel number 

Output 
 

DONE 
STAT 
PUNIT 
PV 
SUNIT 
SV 
TUNIT 
TV 
QUNIT 
QV 

: Output 1 when normal 
: Error information 
: Primary Variable units code 
: Primary Variable value 
: Secondary Variable units code 
: Secondary Variable value 
: Tertiary Variable units code 
: Tertiary Variable value 
: Quaternary Variable units code 
: Quaternary Variable value 

 

■ Function 

When [Common Practice Command 110] command is set to the designated module’s channel, this 
function is used to monitor response data. 
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■Example program 
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(15) HART_CLR command 
 

HART_CLR 

Clear HART command to module 

 

Function block Description 
 

 

Input 
 

REQ 
BASE 
SLOT 
CH 
C_CLR 

: EXECute function when 1(rising edge) 
: Specify base position 
: Specify slot position 
: Used channel number 
: Communication command to be removed 

(bit mask set) 

Output 
 

DONE 
STAT 

: Output 1 when normal 
: Error information 

 

■ Function 

(a) It is used to stop a command being communicated regarding to the designated module’s channel. 

(b) Set bit(BOOL Array) corresponding to a command to be stopped on “C_SET” 

Command 110 61 57 50 48 16 15 13 12 3 2 1 0 

Array index 12 11 10 9 8 7 6 5 4 3 2 1 0 

(c) If “REQ” contact is converted from 0 to 1, function block will be executed. 

(d) Response data to the stopped command is maintained the status at the stopped time. 
 

■Example program 
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7.2.4 Example using PUT/GET instruction 

(1) Enable channel 

(a) You can enable/disable D/A conversion per channel 
(b) Disable channel not using to reduce the conversion cycle per channel 
(c) When channel is not designated, all channels are set as not used 
(d) Enable/disable of D/A conversion is as follows 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 
 

 

— 

 

— 

 

— 

 

— 

 

-— 

 

— 

 

— 

 

— 

 

— 

 

— 

 

— 

 

— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 

 

Bit Description 

0 Stop 

1 Run 

16#0003 : 0000 0000 0000 0011 
   

 
 

 

CH3, CH2, CH1, CH0 

 

(e) The value in B4~B15 is ignored. 
(f) The right figure is example enabling CH0~CH1 of analog input module equipped at slot 0. 

 

 
(2) Output current range setting 

(a) You can set output current range per channel 
(b) When analog output range is not set, all channels are set as 4 ~ 20mA 

(c) Setting of analog output current range is as follows. 

 
- The following is example setting CH0~CH1 as 4~20mA and CH2~CH3 as 0~20mA 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 
 

 
CH3 

 
CH2 

 
CH1 

 
CH0 

 
 

Bit Description 

00 4 mA ~ 20 mA 

01 0 mA ~ 20 mA 

16#4422 : 0000 0000 0101 0000 

 

 
CH3, CH2 CH1, CH0 

 
 
 
 
 
 
 
 
 
 
 

 
Set channel 
to use 

 
 
 
 
 
 
 
 
 
 
 

 
Output range 
setting 
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Output status setting 

 
 
 

(3) Input data range setting 

(a) Digital input data range about analog output can be set per channel. 
(b) When input data range is not set, all channels are set as 0~16000. 
(c) Setting of digital input data range is as follows 

 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 
 

 

CH3 

 

CH2 

 

CH1 

 

CH0 

 

Bit Description 

0000 0 ~ 16000 

0001 -8000 ~ 8000 

0010 Precise value 

0011 0~10000 

16#3012 : 0011 0000 0001 0010 

CH3,   CH2,   CH1,   CH0 

 
 
 

 
Precise value has the following digital input range about analog output range 

1) Current 

Analog output 
 
Digital input 

 

4 ~ 20 ㎃ 
 

0 ~ 20 ㎃ 

Precise Value 4000 ~ 20000 0 ~ 20000 

 
(4) Output status setting 

(a) Default value of output status is 0 
(b) Output statuses according to setting values of output status set area are as following 

Setting Value Content 

0 Retain the previous value 

1 Output the minimum value from the output range 

2 Output the median value from the output range 

3 Output the maximum value from the output range 

 

(c) When setting value other than setting range, error number will display on error code indication 
(_F0001_CH0_ERR). (# means the channel where error occurs at error code) 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 

Variable Contents 

_Fxxyy_CH0_STAT CH0 output status setting 

_Fxxyy_CH1_STAT CH1 output status setting 

_Fxxyy_CH2_STAT CH2 output status setting 

_Fxxyy_CH3_STAT CH3 output status setting 
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(5) Output limit setting 

(a) This area to set enable/disable output limit. It is available to specify it for each channel. 

(b) Default value of output limit set area is 0. 

(b) Setting range of output limit is as follows. 
 
 

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

-— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 
 

 

Bit Description 

0 Disable 

1 Enable 

16#0009: 0000 0000 0000 1001 

CH3, CH2, CH1, CH0 

 
(6) Output high/low limit value setting 

(a) This area to specify output high/low limit for each channel. Setting range varies according to input 
data range. 
1) Unsigned Value: -192~16191 

2) Signed Value: -32768 ~ 32767 

3) Precise Value 
 

Range Setting value 

4 mA ~ 20 mA 3808 ~ 20192 

0 mA ~ 20 mA -240 ~ 20240 

4) Percentile Value: -120 ~ 10120 

 
(b) For details on output limit set function, refer to 2.5.2. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

     
CH# output high/low limit value 

     

 
 

Variable Contents 

_Fxxyy_CH0_HI_LIMIT CH0 output high limit 

_Fxxyy_CH0_LOW_LIMIT CH0 output low limit 

_Fxxyy_CH0_HI_LIMIT CH0 output high limit 

_Fxxyy_CH0_LOW_LIMIT CH0 output low limit 

_Fxxyy_CH0_HI_LIMIT CH0 output high limit 

_Fxxyy_CH0_LOW_LIMIT CH0 output low limit 

_Fxxyy_CH0_HI_LIMIT CH0 output high limit 

_Fxxyy_CH0_LOW_LIMIT CH0 output low limit 
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(7) Change rate control setting 

(a) This is area to set enable/disable change rate control. It is available to specify it for each channel. 
(b) Default value of change rate control is 0. 
(c) Setting range of change rate control is as follows. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

-— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

 
 

— 

C 

H 

3 

C 

H 

2 

C 

H 

1 

C 

H 

0 
 

 

Bit Description 

0 Disable 

1 Enable 

16#0009: 0000 0000 0000 1001 

CH3, CH2, CH1, CH0 

 
 
 

(8) Change rate increase/decrease limit value 

(a) Change rate increase/decreasing value can be set only when Change Rate Control is set to 
Enable. 

(b) Change Rate Alarm setting values are ranged between 0 ~ 16000. 
(c) Change Rate Alarm setting values are specified as following. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

   CH# change rate increase/decrease value     

Range of change rate value is 0 ~ 16000 

 

Variable Contents 

Fxxyy_CH0_INC_RTE CH0 change rate increase value 

Fxxyy_CH0_DEC_RTE CH0 change rate decrease value 

Fxxyy_CH0_INC_RTE CH0 change rate increase value 

Fxxyy_CH0_DEC_RTE CH0 change rate decrease value 

Fxxyy_CH0_INC_RTE CH0 change rate increase value 

Fxxyy_CH0_DEC_RTE CH0 change rate decrease value 

Fxxyy_CH0_INC_RTE CH0 change rate increase value 

Fxxyy_CH0_DEC_RTE CH0 change rate decrease value 
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(9) Error code 

(a) Saves error code detected at HART Analog Input Module. 
(b) The following figure is program example reading error code. 

 
B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0 

 

— — — — — — — — Error code 

 

Variable Contents 

_Fxxyy_CH0_ERR CH0 error code 

_Fxxyy_CH0_ERR CH1 error code 

_Fxxyy_CH0_ERR CH2 error code 

_Fxxyy_CH0_ERR CH3 error code 
 

 

 

 

(c) Error type and contents are as follows. 

 
Error code 

(Dec.) 
Description 

RUN LED 
status 

0 Normal operation RUN LED ON 

10 Module error (ASIC reset error)  

 
Flickers every 

0.2 sec. 

11 Module error (ASIC RAM or Register error) 

13 Module error (EEPROM check error) 

21 Module error (D/A conversion error) 

31# Parameter set error  
 
Flickers every 

1 sec. 

40# Digital input range set error 

60# Output limit high/low value compare error 

70# Change rate control set value error 

※ At error code, # indicates channel where error occurs 

※ For more detail error code, refer to 9.1 

 
(d) In case two error codes occurs, module saves first occurred error code and later occurred error 

code is not saved. 
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8.1 Basic Program 

 
 

Chapter 8 Programming (For 2MLI/2MLR) 
 
 

 

- It describes about how to set operation condition at internal memory of HART Analog Output Module. 

- HART Analog Output Module is equipped at slot 2 

- IO occupation points of HART Analog Input Module are 64 points (Non fixed type) 

- Initial setting condition is saved at internal memory by 1 time input 

 

 
(1) Program example using [I/O Parameter] 
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(2) Program example using [I/O Parameter] 
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Enable CH 

(CH 0,1,2,3) 

Set 

output 

current 

range 

Set input 

data 

type 

Set output 

type 

(CH0: 

Former 

value) 

Set output 

type 

(CH1: 

Former 

value) 

Set output 

type 

(CH2: 

Former 

value) 

Set output 

type 

(CH3: 

Former 

value) 

 
 
 
 
 

(3) Program example using PUT/GET instruction 
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8.2.1 Inverter speed control 

(1) System configuration 
 
 

 

XGP- 

ACF2 

 
2MLI- 

CPUH 

 

2MLI

- 

D24A 

 

2MLF

- 

DC4H 

  

 

(2) Initial setting content 

 

No. Item 
Initial setting 

content 
Variable name 

1 Used channel CH0 0 

2 Input voltage range 0 ~ 20 ㎃ 1 

3 Output data range 0~16000 2 

4 Ch. output type Former value 3 

 

(3) Program description 

(a) At the same time Module Ready Contact is On, output of all the channels will be set to Enable. 

(b) If %IX0.0.1 is On, 0 ㎃ will be output. 

(c) If %IX0.0.1 is Off and %IX0.0.2 is On, 5 ㎃ will be output. 

(d) If %IX0.0.2 is Off and %IX0.0.3 is On, 10 ㎃ will be output. 

(e) If %IX0.0.3 is Off and %IX0.0.4 is On, 15 ㎃ will be output. 

8.2 Application Program 
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(4) Program 

(a) Program example using [I/O Parameter] 
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(b) Program example using [I/O Parameter] 

 

Module ready 

 

Set output enable (CH0) 

Ch0 output value 
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XGQ- 

TR2A 

 
XGF- 

DC4H 

 
2ML

I- 

D24A 

 
2MLI- 

CPUU 

 
XGP- 

ACF2 

 
 
 

 

8.2.2 Program to output error codes of analog output module to BCD display 

(1) System configuration 
 
 

 

Initial value setting 

Saves D/A 
conversion value and 

error code 

Output error code BCD 

%IX0.0.0. 

 

%IX0.0.1 

 
 %IX0.0.2 

 
 
 

Digital BCD display 
(Error display) 

 

 

(2) Details of initial setting 

(a) Used CH: CH 0 

(b) Analog input current range: DC 4 ~ 20 mA 

(c) Digital output data range: 0~16000 

 
 

(3) Program description 

(a) If %IX0.0.1 is On, “OutputValue” and error code will be saved respectively on D/A conversion 

value and “Error Code”. 

(b) If %IX0.0.2 is On, applicable error code will be output to digital BCD display. (%QW0.2.0) 

 
 

(4) Program 

(a) Program example using [I/O Parameter] 
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Set channel status 
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8.2.3 Program to monitor PV through HART communication 

(1) System configuration 
 
 

 
XGP- 

ACF2 

 
2MLI- 

CPUU 

 
2ML

I- 

D24A 

 
2ML

F- 

DC4H 

 
XGQ- 

TR2A 

  

 
(2) Initial setting content 

 

No. Item Initial setting content Variable name 
Value to write at 
internal memory 

1 Used channel CH0, Ch1 0 ‘h0003’or ‘3’ 

2 Input voltage range 4 ~ 20 ㎃ 1 ‘h0000’or ‘0’ 

3 Output data range 0~16000 2 ‘h0000’or ‘0’ 

4 HART communication CH0, 1 40 ‘h0024’or ‘36’ 

 

(3) Program description 

(a) If %MX1 is on, save 12,000 on channel0 output value. 

(b) If %MX2 is on, save 13,600 on channel1 output value. 

(c)  This program is to check responses to each command by executing HART command0 on 

channel 0 and HART command 2 on channel 1. 
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(4) Program 

(a) Program example using [I/O Parameter] 
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(b) Allocate the variables of HARTCMND command. 

 

(c) Select the variable of C_SET. 
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1) Click [Edit Variable]. C_SET variable is declared as 13 BOOL type arrays. Each array means 

13 kinds of HART commands supported on HART input module. Therefore, set a command 

here to be performed through HART communication. 
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2) Click [Initialization] to set HART command bit. If 1 is set to command bit 에 1 to be 

communicated, communication corresponding to the command will be performed. In this 

example, HART command 0 and 1 is set to start communication with the Smart transmitter 

connected with HART input module. Command contents corresponding to each variable are 

shown in the following table. For details on HART commands, refer to Appendix 1. 

 
 

Variable 

HART 

command 

number 

 
Function 

C_SET[0] 0 Read Manufacturer ID and Manufacturer device code 

C_SET[1] 1 Read Primary variable(PV) value and Unit 

C_SET[2] 2 Read percentage of current and range 

 

C_SET[3] 
 

3 
Read current and 4 kinds of variable values 
(Primary Variable, Secondary Variable, Tertiary Value, 
Quaternary Value) 

C_SET[4] 12 Read message 

C_SET[5] 13 Read tag, descriptor, data 

C_SET[6] 15 Read output information 

C_SET[7] 16 Read Final Assemble Number 

C_SET[8] 48 Read Device Status 

C_SET[9] 50 Read Primary variable~ Quaternary Variable assignment 

C_SET[10] 57 Read Unit tag, Unit descriptor, Date 

C_SET[11] 61 
Read Primary variable~ Quaternary Variable and  PV 
analog output 

C_SET[12] 110 Read Primary variable~ Quaternary Variable 
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(d) Program example using PUT/GET command 
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9.1 Error codes 

 

Chapter 9 Diagnosis of Errors 
 

 
 

Details and diagnosis of errors which occur while D/A conversion module is used will be described. 
 

Error Code 

(Dec) 

 
Description 

RUN 

LED 

ALM 

LED 

10 Module error (Reset Check Error)  
Blinks 

every 

0.2 

sec. 

 
 

 
Off 

11 Module error (RAM Check Error) 

12 Module error (Register Check Error) 

13 Module error (E2PROM Check Error) 

21 Module error (D/A Conversion Error) 

31#note) Parameters setting error of current module 
Blinks 

every 

1 sec. 

 

 
Off  

40#note) 

Setting error of current module’s digital input range (If input value is set 

less than -192 or greater than 16191). The range changes based on input 

data type. 

 

60# note) 
Setting error of output limit high/low limit value (If output limit low value is 

set greater than output limit high value) 

 

 
On 

Blinks 

every 

1 sec 70# note) 
Setting error of change rate control value (If change control setting value is 

set less than 0 or greater than 16000) 

 
 

 

Notes 
 

(1) # of the error code stands for the channel with error found. 

(2) If 2 or more errors occur, the module will not save other error codes than the first error code found. 
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(1) If errors occur 
 

Error Code Module Ready Error Bit Status Error Code LED 

 
10, 11, 12, 13, 21 

 
Deleted (OFF) 

 
Set all the channels 

Displayed on system 

area 

Blinks every 0.2 

sec. 

 
31#, 40#, 60#, 70# 

 
Kept 

Set applicable 

channel only 

Displayed on system 

area 

Blinks every 1 

sec 

 

(2) If errors deleted 
 

Error Code Module Ready Error Bit Status Error Code LED 

10, 11, 12, 13, 21 Power On/Off - - - 

31#, 40#, 60#, 70# Kept Clear Clear On 
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RUN LED blinks. 

RUN LED is Off. 

No 

Yes 

Correctly install HART analog output module on the 

base. 

Error due to other module than HART analog 

output module module. Refer to CPU manual for 

more details. 

 

 

 
 

9.2.1 RUN LED blinks 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.2.2 RUN LED is Off 
 

 
 
 

 

 
 

 
 

Yes 

No 

Go to 9.2.8. 

Normally operated if HART analog output module 

with error is changed to another module 

9.2 Diagnosis of errors 

HART analog output module is installed on the base 

correctly 

Yes 

No 

Yes 

No 

RUN LED blinks every 1 sec. 

RUN LED blinks every 0.2 sec. 

SoftMaster can be connected with. 

Yes 

No 

Go to 9.2.8 

Go to 9.2.7 

Contact the nearest agency or A/S center. 

Check error code. 
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D/A output value is hunted too much. 

External power (DC 24V) is supplied. 

 
 

9.2.3 D/A Output Value hunted too much 
 

 

 
 

 
 

 
 
 

 
 

 
 

 
 

 
 

 
Go to 9.2.8. 

D/A output value is hunted too much. 

No 

Yes 

Supply sufficient DC 24V current for HART analog 
output module. 

No 

Yes 

Capacity of DC 24V power supply is sufficient. 

Connect to DC 24V. 

No 

Yes 

Correct the wiring with the external device. 

Wiring between HART analog output module and 
external device is correct. 
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Relationship between digital input value and 

analog output value is not discordant. 

No 

Yes 

No 

Yes 

Contact the nearest agency or Customer Service Center. 

Offset/Gain is specified correctly? 

Specify the correct data type 

 
 

9.2.4 Relationship discordant between Digital Input Value & Analog Output Value 
 

 

 
 

 
 

 

 

 
Go to 9.2.8. 

No 

Yes 

No 

Yes 

Specify the correct channel. 

Used channel is set correctly? 

Refer to 3.2 to correct wiring with the external device 

Wiring between HART analog output module and 
external device is correct? 

Data type is specified correctly? 
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No 

Yes 

Specify D/A input value range correctly. 

D/A output value exceeds setting range. 

D/A output value always exceeds the value 
specified 

No 

Yes 

Refer to 3.2 to correct wiring with the external device 

Go to 7.2.8` 

 
 
 

9.2.5 D/A Output Value always exceeds the value specified 
 

 

 
 

 

 
 

 
 

 
 
 
 

 
 
 

 

No 

Yes 
Contact the nearest agency or A/S center 

Offset/Gain is specified correctly. 

No 

Yes 

Supply external power properly. 

External power is normally supplied 

Wiring between HART analog output module and 
external device is correct. 
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Analog output value does not changed 
accordingly to the D/A input value converted. 

 
 
 

 

9.2.6 Analog Output Value does not changed according to the change of Digital Input 

Value 
 

 

 
 

 

  
 

 

 
 

 
 

 
Go to 7.2.8. 

No 

Yes 

Correct wiring with the external device. 

Wiring with external device is correct? 

No 

Yes 

Contact the nearest agency or A/S center. 

Offset/Gain is specified correctly? 

Specify the applicable channel correctly. No 

Yes 

Applicable channel is specified correctly? 
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HART communication is not performed. 

24V power is normally supplied to the module. 

It is HART analog output module’s Hardware error. 

Contact the nearest Customer Service Center. 

 
 
 

 

9.2.7 HART communication is not performed 
 

 

 

  
 

 
 

 
 

 
 

 

 

9.2.8 Hardware error of HART analog output module 
 

Check if command setting is normally done. If it 

is normally done, there are some problems with 

HART output module or transmitter. Go to 9.2.8 

No 

Yes 

Refer to wiring diagram in this instruction and inspect 

wiring 

Wiring between the transmitter and HART input 
module normally connected. 

No 

Yes 

Supply power to the module. 

Mount to an transmitter for HART communication. No 

Yes 

HART communication is wired to an available 
transmitter. 
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9.2.9 Status check of HART analog output module through SoftMaster System 

Monitoring 

Module type, module information, O/S version and module status of HART analog output module 

can be checked through SoftMaster system monitoring function. 

(1) EXECution sequence 
 

Two routes are available for the execution. 
 

(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to 

display [Module Info.]. 

(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen. 
 

(2) Module Information 
 

(a) Module type: shows the information of the module presently installed. 
 

(b) Module information: shows the O/S version information of HART analog output module. 
 

(c) O/S version: shows the O/S prepared date of HART analog output module. 
 

(d) Module status: shows the present error code. 

 

 
(3) System Monitor 
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10.1 Considerations 

 

Chapter 10 Asset Management System 

Describes what you need to know when using HART analog modules in an asset management system. 

 

 

To use HART analog modules with asset management systems such as PACTware from Peper & Fuchs or Field Device Manager 

from Honeywell, you need to consider the following: 

⚫ To use the HART analog module in the asset management software, the [HART communication] item in the [I/O 

parameters] of the HART analog module must be set to [Pass Through]. 

⚫ You must use ML200 CPU module, Ethernet module, and HART analog module that support asset management 

software. For the OS version for each ML200 module that currently supports this function, refer to Table 10.1. The 

order in which commands sent from the asset management software through the pass-through function are passed to 

the transmitter is as follows. 

Asset Management Software → Ethernet Module → 2MLR CPU Module → HART Analog Module → Transmitter 

Therefore, in order to access HART using asset management software, it is necessary to configure an appropriate 

system with the modules introduced in this section. 

 
[Table 10.1] Asset management software support version for each ML200 

module 

ML200 Module Type Module OS Version Remark 

2MLR CPUH/□ Version 2.81 or higher 
 
 
 
 

Pass-through 

2MLL-EFM□B Version 6.14 or higher 

2MLF-AC4H Version 1.50 or higher 

2MLF-DC4H Version 1.30 or higher 

 

⚫ When using a portable HART transmitter, the HART transmitter must be configured as a secondary master. In some 

cases, communication between the HART analog module and the HART transmitter may conflict. If proper 

communication is not performed on the HART transmitter, set HART communication of the HART analog module to 

[Prohibit] and try again. 

⚫ For information on how to use the asset management software, refer to the user manual published by the manufacturer 

of the software. In order for asset management software to recognize the Ethernet module of ML200 PLC, CommDTM 

must be installed on the system equipped with asset management software. CommDTM of ML200 PLC, please 

contact Honeywell. 

⚫ For details on DTM installation, refer to the pass-through function in Appendix 6. 

⚫ HART communication supported by HART analog module supports two methods. The first is the [User 
Program] method, and the 
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second is the [Pass Through] method. These two methods cannot be used by mixing each channel. If [Pass Through] 

method is set in one channel in HART analog module, [User Program] method set in other channels does not work. 

Therefore, do not mix the two. 
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This section describes Pass-Though Function and how to install and configure the HART on ML200. 
Pass through function of HART analog module is supported through HART-CommDTM for FDT frame application that 
complies with FDT standard 1.2.+. 

 

 
 

10.2.1 About HART-CommDTM 
 

HART-CommDTM supports FDT frame applications conforming to FDT 1.2.+. HART-CommDTM is a HART 
communication DTM that works as a driver for communication between HART devices in the Redundant 
ML200(2MLR-CPU#+HART AI/AO+FEnet) system in the FDT frame application. 
 

(1) Standard 
 

HART-CommDTM supports up to 1,024 channels. The HART analog module can connect one HART device to one 
channel. 
Therefore, HART devices can be connected to the number of channels in the 2MLR system. 
 

⚫ Maximum number of HART channels: 1,024 (configuration can be changed in XML file) 
⚫ Number of HART devices that can be connected to one channel: 1 (multi-drop not supported) 
⚫ Number of HART devices available for the 2MLR system: 1,024 

 
The maximum number of HART channels in the FDT application can be changed as follows in the configuration file 
(DTMConfig.xml) of the HART-CommDTM installation path. 

 

 

 
 

10.2 Pass-Through Function 
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(1) Communication channel assignment 

In the FDT frame application, the channel order is assigned according to the mounting order of the HART module. For 

example, if 4 HART analog modules are installed, the channels are allocated according to the base, slot and channel order 

as shown below. 

 

No. Base Slot Channel HART Channel 

1 2 2 0~3 0~3 

2 2 3 0~3 4~7 

3 4 0 0~3 8~11 

4 4 1 0~3 12~15 

 
When a HART analog module is added, deleted, or the location is changed, the channel of the assigned HART device also 

changes. 
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10.2.2 How to install HART-CommDTM 

(1) Run the HART-CommDTM setup file. 

 
(2) Click the Next button on the screen below. 
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(3) Click the Next button on the screen as below. 

 
(4) Click the Install button on the screen as below. 

 
(5) Click the Finish button on the screen below to complete the installation of HART-CommDTM. 
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10.2.3 Uses of FDT Frame Application 

In this manual, description is based on PACTware. For downloading and installing PACTware, please refer to the PACTware 

homepage. 

 
(1) Addition of HART Communication 

1) 1) Select HOST PC in the device tag of the project, right-click the mouse and execute ADD Device. 

 
2) Select Device on the screen below and click the OK button. 
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(2) Connect with PLC 

1) Select Communication DTM, right-click the mouse and select Parameter. 

 
2) Set IP Address and Poll Address in PLC Communication Settings and click OK button. 
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3) Select Communication DTM, right-click and click Connect. 

 
4) If it is connected normally, it is changed to bold font and the status is changed. 

 
(3) HART device automatic allocation 

1) Select Communication DTM, right-click and select Topology Scan. 
 
 
 

 
 

2) Click the ▶ button in the Topology Scan window. 
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3) Read HART device information in the channel order as shown below. 
 

 
 
 
 
 



Chapter 10 Asset Management System 

10-11 

 

 

 

4) Set Device DTM and click Close button. 
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(4) HART device connection 

1) Select the HART device you want to connect, right-click the mouse and click Connect. 
 

 

2) If you run Connect, you can check the information of the HART device as shown below. 
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10.2.4 Uses of FDT Frame Application on FDM of Honeywell 
 
In this section, it describes an application based on Honeywell FDM(Field Device Manager). Regarding this 
software tool, please contact Honeywell, and visit to https://process.honeywell.com .  
 

Integration on Honeywell solution; 
FDM50x.x and R51x.x 
 

Preparations of ML200 system 

ML200 Module Type Module OS Version Remark 

2MLR CPUH/□ Version 2.81 or higher Pass-through 

2MLL-EFM□B Version 6.14 or higher   

2MLF-AC4H Version 1.50 or higher   

2MLF-DC4H Version 1.30 or higher   

 

Building FDT Networks 
1. On the FDT COMM console, update the DTM library and ensure that only the required (MLPLC) 

communication DTM selected in the DTM library. Ensure to deselect all the existing device DTMs from the 
DTM library. 

2. In the Network View list, right-click the MLPLC COMM DTM interface name and then click Add Device. The 
DTM Selection Dialog appears with the list of Devices connected to channels and click on OK. 

 
 
Configuring CommDTM netwok in FDM 
• IP Address of MLPLC Communication module should be provided in DTM. 

➢ Edit the IP here and save (Highlighted below) 
➢ Add the MLPLC Communication DTM in FDT Comm Console Tool 
➢  

 
 

 

https://process.honeywell.com/
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Building FDT Networks-Configuring 
1. The FDT Comm Console allows user to configure the MLPLC networks and build the complete network 

using MLPLC Communication DTMs.  

 
 

 
Building FDT Networks-Scan for Device 

After configuring the communication DTMs and scanning the network, the MLPLC network is available on the 
FDT Comm Console under MLPLC Communication DTM. 
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Building FDT Networks-Adding a Device 

• Click OK in the DTM Assignment dialog box. The detected devices are visible in the FDT Comm 
Console (Network View > COMM DTM Interface). 

• Launch the FDM Client and load the devices with DD/DTM. 

          
 

Log Files and Information’s requirement 
1. For FDM Log files – Collect Dr. FDM Log files 
2. For Collecting log files for MLPLC Communication with DTM 

➢ Go to C:\Program Files (x86)\Honeywell\Hart CommDTM 
➢ Copy log.txt 
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Command 

No. 

 
No. 

Data 

type 

Device 

(D00000) 

 
Description 

 
Valid size 

 
 
 
 
 

0 

(10 Word) 

1 WORD D00000 Manufacturer ID 1 Byte 

2 WORD D00001 Manufacturer device type code 2 Byte 

3 INT D00002 Number of preambles required 1 Byte 

4 INT D00003 Universal Command Revision 1 Byte 

5 INT D00004 Device Specific Command Revision 1 Byte 

6 INT D00005 Software Revision 1 Byte 

7 INT D00006 Hardware Revision(x10) 2 Byte 

8 WORD D00007 Device Function Flags 1 Byte 

9 DWORD D00008~9 Device ID number 3 Byte 

1 

(3 Word) 

1 WORD D00000 Primary Variable units code 1 Byte 

2 REAL D00001~2 Primary Variable 4 Byte 

2 

(4 Word) 

1 REAL D00000~1 Primary Variable loop current (mA) 4 Byte 

2 REAL D00002~3 Primary Variable percent of range 4 Byte 

 
 
 
 
 

3 

(14 Word) 

1 REAL D00000~1 Primary Variable loop current (mA) 4 Byte 

2 WORD D00002 Primary Variable units code 1 Byte 

3 REAL D00003~4 Primary Variable 4 Byte 

4 WORD D00005 Secondary Variable units code 1 Byte 

5 REAL D00006~7 Secondary Variable 4 Byte 

6 WORD D00008 Tertiary Variable units code 1 Byte 

7 REAL D00009~10 Tertiary Variable 4 Byte 

8 WORD D000011 Quaternary Variable units code 1 Byte 

9 REAL D000012~13 Quaternary Variable 4 Bytes 

12 

(18 Word) 

1 STRING D00000~8 Message(1/2) 16 Byte 

2 STRING D00009~17 Message(2/2) 16 Byte 

 
 

13 

(17 Word) 

1 STRING D00000~4 Tag~ Null 8 Byte 

2 STRING D00005~13 Descriptor~ Null 16 Byte 

3 INT D000014 Year 2 Byte 

4 INT D000015 Month 1 Byte 

5 INT D000016 Day 1 Byte 
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Command 

No. 

 
No. 

Data 

type 

Device 

(D00000) 

 
Description 

 
Valid size 

 
 
 
 
 

15 

(11 Word) 

1 WORD D00000 Primary Variable alarm select code 1 Byte 

2 WORD D00001 Primary Variable transfer function code 1 Byte 

3 WORD D00002 Primary Variable range units code 1 Byte 

4 REAL D00003~4 Primary Variable upper range value 4 Byte 

6 REAL D00005~6 Primary Variable lower range value 4 Byte 

8 REAL D00007~8 Primary Variable damping value(sec) 4 Byte 

10 WORD D00009 Write-protect code 1 Byte 

11 WORD D00010 Private-label distributor 1 Byte 

16 

(2 Word) 

 
1 

 
DWORD 

 
D00000~1 

 
Final assembly number 

 
3 Byte 

 
 

 
48 

(15 Word) 

1 WORD D00000~2 Device-specific status 6 Byte 

2 WORD D00003 Extended device-specific status (V6.0) 1 Byte 

3 WORD D00004 Operational modes (V5.1) 1 Byte 

4 DWORD D00005~6 Analog outputs saturated (V5.1) 3 Byte 

5 DWORD D00007~8 Analog outputs fixed (V5.1) 3 Byte 

6 DWORD D00009~14 Device-specific status2 11 Byte 

 
 

50 

(4 Word) 

1 WORD D00000 Primary Device Variable 1 Byte 

2 WORD D00001 Secondary Device Variable 1 Byte 

3 WORD D00002 Tertiary Device Variable 1 Byte 

4 WORD D00003 Quaternary Device Variable 1 Byte 

 
 

57 

(17 Word) 

1 STRING D00000~4 Unit tag~ Null 8 Byte 

2 STRING D00005~13 Unit descriptor~ Null 16 Byte 

3 WORD D000014 Unit year 2 Byte 

4 WORD D000015 Unit month 1 Byte 

5 WORD D000016 Unit day 1 Byte 

 
 
 
 
 

 
61 

(15 Word) 

1 WORD D00000 PV Analog Output units code 1 Byte 

2 REAL D00001~2 PV Analog Output level 4 Byte 

3 WORD D00003 Primary Variable units code 1 Byte 

4 REAL D00004~5 Primary Variable 4 Byte 

5 WORD D00006 Secondary Variable units code 1 Byte 

6 REAL D00007~8 Secondary Variable 4 Byte 

7 WORD D00009 Tertiary Variable units code 1 Byte 

11 REAL D00010~11 Tertiary Variable 4 Byte 

13 WORD D00012 Quaternary Variable units code 1 Byte 

14 REAL D00013~14 Quaternary Variable 4 Byte 
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Command 

No. 

 
No. 

Data 

type 

Device 

(D00000) 

 
Description 

 
Valid size 

 
 
 
 
 

110 

(12 Word) 

1 WORD D00000 Primary Variable units code 1 Byte 

2 REAL D00001~2 Primary Variable value 4 Byte 

3 WORD D00003 Secondary Variable units code 1 Byte 

4 REAL D00004~5 Secondary Variable value 4 Byte 

5 WORD D00006 Tertiary Variable units code 1 Byte 

6 REAL D00007~8 Tertiary Variable value 4 Byte 

7 WORD D00009 Quaternary Variable units code 1 Byte 

8 REAL D00010~11 Quaternary Variable value 4 Byte 
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The table below shows codes assigned to manufacturers and those manufacturers. 

 
 

Decimal Hex Manufacturer Decimal Hex Manufacturer 

1 01 Acromagey 26 1A ABB 

2 02 Allen-Bradley 27 1B Leeds & Northup 

3 03 Ametek 28 1C Leslie 

4 04 Analog Devices 29 1D M-System Co. 

5 05 ABB 30 1E Measurex 

6 06 Beckman 31 1F Micro Motion 

7 07 Bell Microsenser 32 20 Moore Industries 

8 08 Bourns 33 21 PRIME Measurement Products 

9 09 Bristol Babcock 34 22 Ohkura Electric 

10 0A Brooks Instrument 35 23 Paine 

11 0B Chessell 36 24 Rochester Instrument Systems 

12 0C Combustion Engineering 37 25 Ronan 

13 0D Daniel Industries 38 26 Rosemount 

14 0E Delta 39 27 Peek Measurement 

15 0F Dieterich Standard 40 28 Actaris Neptune 

16 10 Dohrmann 41 29 Sensall 

17 11 Endress+Hauser 42 2A Siemens 

18 12 ABB 43 2B Weed 

19 13 Fisher Controls 44 2C Toshiba 

20 14 Foxboro 45 2D Transmation 

21 15 Fuji 46 2E Rosemount Analytic 

22 16 ABB 47 2F Metso Automation 

23 17 Honeywell 48 30 Flowserve 

24 18 ITT Barton 49 31 Varec 

25 19 Thermo Measure Tech 50 32 Viatran 
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Decimal Hex Manufacturer Decimal Hex Manufacturer 

51 33 Delta/Weed 76 4C VAF Instruments 

52 34 Westinghouse 77 4D Westlock Controls 

53 35 Xomox 78 4E Drexelbrook 

54 36 Yamatake 79 4F Saab Tank Control 

55 37 Yokogawa 80 50 K-TEK 

56 38 Nuovo Pignone 81 51 SENSIDYNE, INC 

57 39 Promac 82 52 Draeger 

58 3A Exac Corporation 83 53 Raytek 

59 3B Mobrey 84 54 Siemens Milltronics PI 

60 3C Arcom Control System 85 55 BTG 

61 3D Princo 86 56 Magnetrol 

62 3E Smar 87 57 Metso Automation 

63 3F Foxboro Eckardt 88 58 Siemens Milltronics PI 

64 40 Measurement Technology 89 59 HELIOS 

65 41 Applied System Technologies 90 5A Anderson Instrument Company 

66 42 Samson 91 5B INOR 

67 43 Sparling Instruments 92 5C ROBERTSHAW 

68 44 Fireye 93 5D PEPPERL+FUCHS 

69 45 Krohne 94 5E ACCUTECH 

70 46 Betz 95 5F Flow Measurement 

71 47 Druck 96 60 Courdon-Haenni 

72 48 SOR 97 61 Knick 

73 49 Elcon Instruments 98 62 VEGA 

74 4A EMCO 99 63 MTS Systems Corp 

75 4B Termiflex Corporation 100 64 Oval 
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Decimal Hex Manufacturer Decimal Hex Manufacturer 

101 65 Masoneilan-Dresser 126 7E Paper Machine Components 

102 66 BESTA 127 7F LABOM 

103 67 Ohmart 128 80 Danfoss 

104 68 Harold Beck and Sons 129 81 Turbo 

105 69 rittmeyer instrumentation 130 82 TOKYO KEISO 

106 6A Rossel Messtechnik 131 83 SMC 

107 6B WIKA 132 84 Status Instruments 

108 6C Bopp & Reuther Heinrichs 133 85 Huakong 

109 6D PR Electronics 134 86 Duon System 

110 6E Jordan Controls 135 87 Vortek Instruments, LLC 

111 6F Valcom s.r.l. 136 88 AG Crosby 

112 70 US ELECTRIC MOTORS 137 89 Action Instruments 

113 71 Apparatebau Hundsbach 138 8A Keystone Controls 

114 72 Dynisco 139 8B Thermo Electronic Co 

115 73 Spriano 140 8C ISE Magtech 

116 74 Direct Measurement 141 8D Rueger 

117 75 Klay Instruments 142 8E Mettler Toledo 

118 76 CiDRA CORP 143 8F Det-Tronics 

119 77 MMG AM DTR 144 90 Thermo MeasureTech 

120 78 Buerkert Fluid Control Systems 145 91 DeZURIK 

121 79 AALIANT Process Mgt 146 92 Phase Dynamics 

122 7A PONDUS INSTRUMENTS 147 93 WELLTECH SHANGHAI 

123 7B ZAP S.A. Ostrow Wielkopolski 148 94 ENRAF 

124 7C GLI 149 95 4tech ASA 

125 7D 
Fisher-Rosemount Performance 
Technologies 

150 96 Brandt Instruments 
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Decimal Hex Manufacturer Decimal Hex Manufacturer 

151 97 Nivelco 176 B0 Phoenix Contact 

152 98 Camille Bauer 177 B1 Andean Instruments 

153 99 Metran 178 B2 American Level Instrument 

154 9A Milton Roy Co. 179 B3 Hawk 

155 9B PMV 180 B4 YTC 

156 9C Turck 181 B5 Pyromation Inc. 

157 9D Panametrics 182 B6 Satron Instruments 

158 9E R. Stahl 183 B7 BIFFI 

159 9F Analytical Technologies Inc. 184 B8 SAIC 

160 A0 FINT 185 B9 BD Sensors 

161 A1 BERTHOLD 186 BA Andean Instruments 

162 A2 InterCorr 187 BB Kemotron 

163 A3 China BRICONTE Co Ltd 188 BC APLISENS 

164 A4 Electron Machine 189 BD Badger Meter 

165 A5 Sierra Instruments 190 BE HIMA 

166 A6 Fluid Components Intl 191 BF GP:50 

167 A7 Solid AT 192 C0 Kongsberg Maritime 

168 A8 Meriam Instrument 193 C1 ASA S.p.A. 

169 A9 Invensys 194 C2 Hengesbach 

170 AA S-Products 195 C3 Lanlian Instruments 

171 AB Tyco Valves & Controls 196 C4 Spectrum Controls 

172 AC Micro Matic Instrument A/S 197 C5 Kajaani Process Measurements 

173 AD J-Tec Associates 198 C6 FAFNIR 

174 AE TRACERCO 199 C7 SICK-MAIHAK 

175 AF AGAR 200 C8 JSP Nova Paka 
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Decimal Hex Manufacturer Decimal Hex Manufacturer 

201 C9 MESACON 24576 6000 ExSaf 

202 CA Spirax Sarco Italy 24577 6001 SEOJIN INSTECH 

203 CB L&J TECHNOLOGIES 24578 6002 TASI FLOW 

204 CC Tecfluid S.A. 24579 6003 Daihan Control 

205 CD Sailsors Instruments 24580 6004 APM 

206 CE Roost 24581 6005 ORANGE INSTRUMENTS. UK 

207 CF KOSO 24582 6006 BARTEC 

208 D0 MJK 24583 6007 Detcon 

209 D1 GE Energy 24584 6008 MSA 

210 D2 BW Technologies 24585 6009 METROVAL 

211 D3 HEINRICHS 24586 600A Etalon Rus 

212 D4 SIC 24587 600B JOGLER 

213 D5 HACH LANGE 24588 600C KSB 

214 D6 Exalon Instruments 24589 600D Richter CT 

215 D7 FAURE HERMAN 24590 600E NET SAFETY 

216 D8 STI S.r.l. 24591 600F ECanada 

217 D9 Manometr-Kharkiv 24592 6010 SUPCON 

218 DA Dalian-Instruments 24593 6011 DKK - TOA 

219 DB Spextrex 24594 6012 Dwyer Instruments 

220 DC SIPAI Instruments 24595 6013 FineTek 

221 DD Advanced Flow 24596 6014 Top Worx Inc. 

222 DE Rexa. Koso America 24597 6015 Hoffer Flow Controls 

223 EF General Monitors, Inc. 24598 6016 Dust Networks 

224 E0 Manufacturer Expansion 24599 6017 Forbes Marshall 

249 F9 
HART Communication 
Foundation 

24600 6018 All Measures, Ltd. 
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` Hex Manufacturer Decimal Hex Manufacturer 

24601 6019 MACTek 24612 6024 SkoFlo Industries, Inc. 

24602 601A CSI 24613 6025 StoneL Corporation 

24603 601B TC Fluid Control 24614 6026 EUREKA FLOW 

24604 601C Rohrback Cosasco 24615 6027 BEKA associates 

24605 601D AirSprite 24616 6028 Capstar Automation 

24606 601E Microcyber Inc. 24617 6029 Pulsar 

24607 601F TIG 24618 602A Elemer 

24608 6020 ifm prover Gmbh 24619 602B Soft Tech Group 

24609 6021 FLEXIM - - - 

24610 6022 TOKIMEC.INC - - - 

24611 6023 SBEM - - - 
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The table below shows each unit’s meaning and abbreviation. These codes are used to show process 

variables’ range. 

 

Decimal Hex Description Symbol Decimal Hex Description Symbol 

1 01 
Inches of Water 
(68 °F) 

InH2O 68 °F 26 1A 
Cubic Feet per 
Second 

ft3/sec 

2 02 
Inches of Mercury 
(0°C) 

InHg 0°C 27 1B Cubic Feet per Day ft3/day 

3 03 
Feet of Water 
(68 °F) 

FtH2O 68 °F 28 1C 
Cubic Meters per 
Second 

m3/sec 

4 04 
Millimeters of Water 
(68 °F) 

mmH2O 
68 °F 

29 1D 
Cubic Meters per 
Day 

m3/day 

5 05 
Millimeters of 
Mercury (0°C) 

mmHg 0°C 30 1E 
Imperial Gallons per 
Hour 

ImpGal/hr 

6 06 
Pounds per Square 
Inch 

PSI 31 1F 
Imperial Gallons per 
Day 

ImpGal/day 

7 07 Bars bar 32 20 Degrees Celsius °C 

8 08 Millibars mbar 33 21 Degrees Fahrenheit °F 

9 09 
Grams per Square 
Centimeter 

g/cm2 34 22 Degrees Rankin °R 

10 0A 
Kilograms per 
Square Centimeter 

kg/cm2 35 23 Degrees Kelvin °K 

11 0B Pascals PA 36 24 Millivolts mV 

12 0C Kilopascals kPA 37 25 Ohms Ohm 

13 0D Torr torr 38 26 Herts Hz 

14 0E Atmospheres ATM 39 27 Milliamperes mA 

15 0F 
Cubic Feet per 
Minute 

ft3/min 40 28 Gallons gal 

16 10 
Gallons per Minute 
(US) 

gal/min 41 29 Liters L 

17 11 Liters per Minute L/min 42 2A Imperial Gallons ImpGal 

18 12 
Imperial Gallons per 
Minute 

ImpGal/min 43 2B Cubic Meters m3 

19 13 
Cubic Meters per 
Hour 

m3/hr 44 2C Feet ft 

20 14 Feet per Second ft/s 45 2D Meters m 

21 15 Meters per Second m/s 46 2E 
Barrels (1 barrel = 
42 US gallons) 

bbl 

22 16 
Gallons per Second 
(US) 

gal/sec 47 2F Inches in 

23 17 
Million Gallons per 
Day 

MilGal/day 48 30 Centimeters cm 

24 18 Liters per Second L/s 49 31 Millimeters mm 

25 19 
Million Liters per 
Day 

MilL/day 50 32 Minutes min 
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Decimal Hex Description Symbol Decimal Hex Description Symbol 

51 33 Seconds sec 76 4C Kilograms per Day kg/day 

52 34 Hours hr 77 4D 
Metric Tons per 
Minute 

MetTon/min 

53 35 Days day 78 4E Metric Tons per Hour MetTon/hr 

54 36 Centistokes centi stokes 79 4F Metric Tons per Day MetTon/day 

55 37 Centipoise centi poise 80 50 Pounds per Second lb/s 

56 38 Microsiemens uMho 81 51 Pounds per Minute lb/min 

57 39 Percent % 82 52 Pounds per Hour lb/hr 

58 3A Volts V 83 53 Pounds per Day lb/day 

59 3B pH pH 84 54 
Short Topns per 
Minute 

ShTon/min 

60 3C Grams g 85 55 Short Tons per Hour ShTon/hr 

61 3D Kilograms kg 86 56 Short Tons per Day ShTon/day 

62 3E Metric Tons MetTon 87 57 Long Tons per Hour LTon/hr 

63 3F Pounds lb 88 58 Long Tons per Day LTon/day 

64 40 Short Tons ShTon 89 59 Deka Therm Dth 

65 41 Long Ton LTon 90 5A Specific Gravity Units SGU 

66 42 
Milli Siemens per 
Centimeter 

mSiemen/c 
m 

91 5B 
Grams per Cubic 
Centimeter 

g/cm3 

67 43 
Micro Siemens per 
Centimeter 

uSiemen/c 
m 

92 5C 
Kilograms per Cubic 
Meter 

kg/m3 

68 44 Newton N 93 5D 
Pounds per Gallon 
(US) 

lb/gal 

69 45 Newton Meter Nm 94 5E 
Pounds per Cubic 
Feet 

lb/ft3 

70 46 Grams per Second g/s 95 5F Grams per Milliliter g/mL 

71 47 Grams per Minute g/min 96 60 Kilograms per Liter kg/L 

72 48 Grams per Hour g/hr 97 61 Grams per Liter g/L 

73 49 
Kilograms per 
Second 

kg/s 98 62 
Pounds per Cubic 
inch 

lb/In3 

74 4A Kilograms per Minute kg/min 99 63 
Short Topns per 
Cubic Yard 

ShTon/Yd3 

75 4B Kilograms per Hour kg/hr 100 64 Degrees Twaddell °Twad 



Appendix3. Engineering Units Code 

Appendix 3-4 

 

 

 

Decimal Hex Description Symbol Decimal Hex Description Symbol 

101 65 Degree Brix °Brix 126 7E Foot Pounds Force ft lb force 

102 66 
Degrees Baume 
Heavy 

°BaumHv 127 7F Kilo Watt kW 

103 67 
Degrees Baume 
Light 

°BaumLt 128 80 Kilo Watt Hour kWh 

104 68 Degrees API °API 129 81 Horsepower HP 

105 69 
Percent Solids per 
Weight 

%Sol/wt 130 82 
Cubic Feet per 
Hour 

ft3/hr 

106 6A 
Percent Solids per 
Volume 

%Sol/vol 131 83 
Cubic Meters per 
Minute 

m3/min 

 

107 
 

6B 
 

Degrees Balling 
 

°Ball 
 

132 
 

84 
Barrels per Second 
(1 barrel = 42 US 
gallons) 

 

bbl/s 

 

108 
 

6C 
 

Proof per Volume 
 

proof/vol 
 

133 
 

85 
Barrels per Minute 
(1 barrel = 42 US 
gallons) 

 

bbl/min 

 

109 
 

6D 
 

Proof per Mass 
 

proof/mass 
 

134 
 

86 
Barrels per Hour (1 
barrel = 42 US 
gallons) 

 

bbl/hr 

 

110 
 

6E 
 

Bushels 
 

bush 
 

135 
 

87 
Barrels per Day (1 
barrel = 42 US 
gallons) 

 

bbl/day 

111 6F Cubic Yards yd3 136 88 
Gallons per Hour 
(US) 

gal/hr 

112 70 Cubic Feet ft3 137 89 
Imperial Gallons 
per Second 

ImpGal/s 

113 71 Cubic Inches in3 138 8A Liters per Hour L/hr 

114 72 Inches per Second in/s 139 8B Parts per Million ppm 

115 73 Inches per Minute in/min 140 8C 
Mega Calories per 
Hour 

MCal/h 

116 74 Feet per Minute ft/min 141 8D 
Mega Joule per 
Hour 

MJ/h 

117 75 Degrees per Second °/s 142 8E 
British Thermal 
Unit per Hour 

BTU/h 

118 76 
Revolutions per 
Second 

rev/s 143 8F Degrees ° 

119 77 
Revolutions per 
Minute 

rpm 144 90 Radian rad 

120 78 Meters per Hour m/hr 145 91 
Inches of Water 
(60 °F) 

InH2O 60°F 

 

121 
 

79 
Normal Cubic Meters 
per Hour "MKS 
System" 

 

m3/hr 
 

146 
 

92 
Micrograms per 
Liter 

 

ug/L 

122 7A 
Normal Liters per 
Hour "MKS System" 

L/hr 147 93 
Micrograms per 
Cubic Meter 

ug/m3 

 

123 
 

7B 
Standard Cubic Feet 
per Minute "US 
System" 

 

ft3/min 
 

148 
 

94 
Percent 
Consistency 

 

%consistency 

124 7C 
Liquid Barrel (= 31.5 
US gallons) 

bblLiq 149 95 Volume Percent volume % 

125 7D Ounce ounce 150 96 
Percent Steam 
Quality 

%StmQual 
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Decimal Hex Description Symbol Decimal Hex Description Symbol 

151 97 Feet-Inch-1/16ths Ftin16 235 EB gallons per day usg/d 

152 98 
Cubic Feet per 
Pound 

ft3/lb 236 EC hectoliters hL 

153 99 Picofarads pF 237 ED megapascals MPa 

154 9A Millimeters per Liter mL/L 238 EE 
inches of water at 
4 °C (39.2 °F) 

inH2O (4 °C 
or 39.2 °F) 

 

155 
 

9B 
 

Microliters per Liter 
microliters/ 

L 

 

239 
 

EF 
millimeters of water 
at 4 °C (39.2 °F) 

mmH2O 
(4 °C or 
39.2 °F) 

156 9C percent plato % plato     

 

157 
 

9D 
percent lower 
explosion level 

% lower 
explosion 

level 

    

158 9E mega calorie Mcal     

159 9F Kohms kohm     

160 A0 mega joule MJ     

161 A1 british thermal unit BTU     

162 A2 normal cubic meter 
normal 
cubic m 

    

163 A3 normal liter normal L     

164 A4 standard cubic feet 
normal 
cubic ft 

    

165 A5 parts per billion parts/billion     
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Terms and abbreviation used in the user’s manual and the analog module in general are as described below. 

 
 

■ A/D converter: converts analog to digital value proportionately to the size of analog input signal. 

 
 

■ Analog input module: as a module with the circuit to convert analog voltage/current input signal to digital 

value, it has resolution of 14 and 16 bits according to converters. 

 
 

■ Channel: related with the terminal of analog I/O module and connected to various voltage/current I/O 

devices respectively, with applicable data and diagnosis function as well. 

 
■ Conversion time: time necessary for analog input module to sample and convert the analog signal for the 

processor inside the module to get digital-converted value input. On the other hand, it is time necessary for 

analog output module to convert the digital value output from the processor inside the module to analog 

output signal so to transmit to the output channel. 

 
■ D/A converter: related with the output module, it is used to make continuous size of analog voltage and 

current signal proportionately to the digital value. 

 
 

■ Full scale: defined as the size of voltage/current where the normal operation is executed. 

 
 

■ Full scale error: displayed with graph difference between agreeable analog-converted value and actual 

analog-converted value. 

 
■ Full scale range: displayed with difference between the maximum and the minimum of the analog input. 

 
 

■ LSB (Least Significant Bit): It means the minimum valid bit. Even though it means the lowest-level bit in 

digital code, in this instruction, it is used as the smallest unit that can be distinguished by A/D converter. 

 
■ Transmitter: A circuit to receive analog signals or data and convert them to forms that can be transmitted 

via media (transmission). 

 
■ Linearity error: analog I/O is related between continuous voltage/current value and digital value, whose 

agreeable I/O value is defined as a line within a distance of the min. 1LSB of voltage/current. I/O linearity 

error is regarded as the declination between the agreeable-converted value and the actual-converted value 

on the graph. 
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Actual-converted value 
 

 
Agreeable-converted value 

 
 
 
 
 
 
 

 
■ Multiplexer: a switching circuit where many signals share one A/D converter or D/A converter. 

 
 

■ Analog output module: a module with output circuit to convert analog DC voltage or current signal 

proportionate to digital value delivered to the module from the processor. 

 
■ Resolution: the min. value recognizable by a measuring instrument, which is usually displayed in the 

engineering unit (1mv) or the number of bits. In other words, 16383 types of output are available for 14 

bits. 

 
■ Filter: used to reduce the change of the digital-converted value output by sudden change of the 

external noise or input for the analog circuit, through two methods of S/W and H/W filters. 

 
■ Accuracy: displayed with the max. declination between agreeable value and output voltage or current 

for the whole range of output. On the other hand, it is displayed with the max. declination between 

agreeable value and digital-converted input signal value for the whole range of input. Generally, 

percentage will be displayed for the full scale. 

Gain, Offset and Linearity error are all included in the error type available. 

 
 

■ Output accuracy: displayed with the difference between the actual analog output voltage/current 

value and the agreeable-converted value on the conversion graph for the full scale, with Offset, Gain 

and Drift error factors included as well as normal temperature (25℃) and available temperature range 

displayed respectively. 

 
■ HART: HART stands for Highway Addressable Remote Transducer. HART field communication 

protocol is a standard commonly used in the world and it is also an open communication technology 

for smart process measurement. HART is a registered trademark of HART Communication Foundation. 
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■ HART Communication Foundation(HCF): HART Communication Foundation is an independent non- 

profit organization to support application of HART technology throughout the world. Established in 

1993, this organization manages HART protocol as its technical owners. Major measurement 

manufacturers and users in the world support this foundation. Membership is open to any person who 

is interested in HART technology. 

 
■ Universal Commands: Commands that allow the user to access essential and useful information for 

operating general plants such as measuring machine’s manufacturer, model, tag, serial number, descriptor, 

range limit, process variable. All of HART devices need to realize universal commands. 

 
■ Common Practice Commands: Commands to provide access to functions that can be performed on many 

HART devices. All of HART devices do not provide all of common practice commands. 

 
■ Device specific commands: Command to provide access to functions that can be performed only on 

specific HART devices. 

 
 

■ Monodrop: Only one field device is communicated while connected with only one transmission medium. 

Field device’s HART Address is fixed to 0. 

 
■ Multidrop: More than two field devices are connected with one transmission medium for communication. In 

the Multidrop mode, up to 15 field devices can be connected with HART master. In this mode, analog signal 

conversion is not supported. The master designates address between 0 through 15 to distinguish field 

devices. 

 
■ Primary Variable: As the first value assigned to HART dynamic variables, it the most basic measuring value. 

 
 

■ Frequency Shift Keying(FSK): A communication method to determine and transmit digital signal 0 and 1 by 

differentiating carrier wave’s frequency. 
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(1) Dimensions of 2MLF-
DC4H 

 
 

(Unit : mm) 
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